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1 Notes for QSWAT users

For experienced QSWAT users we first highlight the things that are new or different in 
QSWAT+.

 Environment: You use 64-bit tools (Installation, Environment and Tools Required) 
and QSWAT+ uses SQLite instead of Microsoft Access databases.  Linux and MacOS
are also supported.  You build and run SWAT+ models using only free, open-source 
software.

 QGIS is version 3, not 2: this means we are using Python 3 instead of Python 2.  
The differences for the user are not very great, and you should soon get used to them. 
QGIS 3 can be safely installed alongside an existing QGIS 2 installation.

 Streams and channels: Subbasins are formed as before by stream drainage areas, but
subbasins can contain multiple channels (Creating channels and streams).  HRUs 
drain to channels, and so are more precisely positioned than in QSWAT..

 Landscape units:  Areas draining to channels can be divided into floodplain  and 
upslope areas, each forming a landscape unit (Creating landscape units).  HRUs 
belong to landscape units.

 Short channel merge: Subbasins can be merged as in QSWAT, but in addition 
channels can be merged within subbasins (Merging short channels) with the aim of 
avoiding small HRUs and landscape units.

 Lakes: Lakes may be added, defined by shapefile. (Adding lakes)

 Ponds and reservoirs: Areas with landuse WATR can be used to form ponds or 
reservoirs, if the user marks a pond or reservoir, or sets a threshold for when WATR 
becomes a reservoir (Ponds and reservoirs).  WATR areas that do not become ponds 
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or reservoirs, or included in lakes, are changed to landuse WETW; there are no longer
HRUs with landuse WATR.

 Grid models: As well as models based on delineated subbasins, grid models can be 
created and used (Using grid models).

 Parameters: A wide range of parameters can be set using the parameters form 
(Parameter settings).

 Environmental flows:  A range of environmental flows can be generated 
(Environmental flows).

1 Environment and Tools Required

 Microsoft Windows (any version, as far as we are aware) or Linux (probably any 
recent version, but only tested on Ubuntu) or MacOS (only tested on Catalina)

 Text editor (e.g. NotePad in Windows, gedit in Linux, TextEdit in MacOS, Emacs in 
any) that enables you to read and edit ASCII text files.

 QGIS.  The instruction in this document assume you have a 64 bit machine, and you 
should use the 64 bit versions of QGIS, QSWAT+ and SWAT+.  

 A tool that allows for viewing and editing SQLite databases.  A good choice in 
Windows is the free, open source SQLiteStudio which can be downloaded from 
https://sqlitestudio.pl.  In Linux and on Macs you can also use SQLiteStudio, or you 
may find SQLiteBrowser available in your distribution.

1.1 Source code

The source code for QSWAT+ is available from 
https://bitbucket.org/ChrisWGeorge/qswatplus3

 

2 Installation

2.1 Windows

 Install QGIS by running https://qgis.org/downloads/QGIS-OSGeo4W-3.28.7-1.msi 
(or later version)... It can be downloaded from the QGIS download page, where you 
should select the most stable version LTR.  Use the default folder C:/Program 
Files/QGIS 3.28.7 as the installation folder.

 Note that you can use a later version than 3.28.  If you want to use an earlier one it 
must be at least 3.16.14.  You also need to be careful about the version of Python it 
uses.  QGIS 3.16 came in two versions, one with a .exe installer and one with a .msi 
installer, and the one with the .exe installer uses Python 3.7, while the one with a .msi 
installer uses Python 3.9.  You can see which one you have by checking if you have 
the folder C:\Program Files\QGIS 3.16\apps\Python37 (.exe) or C:\Program Files\
QGIS 3.16.14\apps\Python39 (.msi).  For a Python 3.7 version of QGIS you must 
download a QSWATPlus3_64 installer from 
https://bitbucket.org/ChrisWGeorge/qswatplus3/downloads/.  For a Python 3.9 
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version you need a QSWATPlus3_9 installer from the same page or from the SWAT+ 
page of the SWAT website.  If you select a plugin incompatible with your version of 
QGIS the plugin will appear in the plugins menu but the QSWAT+ button will not 
appear.  You will find a message including the phrase "Failed to load Cython module: 
wrong architecture?" in the QSWAT+ tab of the QGIS log messages.
We recommend that you use the current long term release (LTR) because it will stay 
stable for some time (currently a year) and is the version that QSWAT+ is tested 
against.

 Install SWAT+ by running  swatplustools-installer, version 2.1 or later. It can be 
downloaded from SWAT+ page of the SWAT website.  You may be informed that 
Windows protected your PC, and you need to click More info and then Run anyway to 
proceed with the installation.  You then need to accept the license. This is a 
combination installer that provides QSWAT+, the SWAT+ Editor, and some other 
materials.  You can choose which components you need (for the first install QSWAT+,
the SWAT+ Editor, probably the global weather generator, and the 
SSURGO/STATSGO soil data if you will be modelling anywhere in the USA), and 
you also need to make a couple of choices:

o The SWAT+ editor, together with the SWAT+ program and other materials are 

by default installed in C:/SWAT/SWATPlus, but the user doing the installation 
has the option of changing this directory.  If you choose to change from this 
default, you will need to use the QSWAT+ Parameters form the first time you 
run QSWAT+ to set the SWATPlus directory to whatever path you chose.  The 
setting will then be retained by QSWAT+ and the same one used in future, 
unless you change it again.

o QSWAT+ is a plugin for QGIS.  It can be installed for all users, or just the 

user running the installer.  In the second case the plugin is placed within the 
user's personal files, and will only appear as a plugin when the same user starts
QGIS.  This does not require admin privileges and is the natural choice if you 
are installing on your personal laptop, or on a machine where you are the 
primary user.  In the all users case, the plugin is placed within the QGIS 
installation's files.  This will require admin privileges.  It also has the 
consequence that if you upgrade QGIS, QSWAT+ will need to be reinstalled.  
The installer may also have to ask you to browse to where QGIS is installed, if
it can't find it in the usual places.
Note that it is possible to install QSWAT+ individually for more than one user,
if this is more convenient than using the all users option, simply by each user 
running the QSWAT+ component of the swatplustools-installer.

2.2 Linux

 Your Linux distribution may have a QGIS package as part of its standard collection.  
Provided it is QGIS 3.16 version or later (not QGIS 2) you will be OK using it, and 
you can use the standard package management system to install it.   The instructions 
that follow here are an alternative for obtaining the latest long term release of QGIS, 
currently 3.28. 
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 Start by going to the QGIS download page and selecting Linux.  Follow the 
instructions for your distribution.  Note the instructions on the QGIS page include 
installing qgis-plugin-grass, but this is not necessary for QSWAT+, i.e. the install 
command needed is merely sudo apt install qgis (though Ubuntu seemed to 
install GRASS anyway).

 Install QSWAT+ using the swatplus-linux-installer from the SWAT+ page of the 
SWAT website.  This takes the form of a compressed tar archive.  Save it somewhere,
open a terminal and cd to the directory it is saved in.  Use the command
tar -xvf swatplus-linux-installer.tgz

to unpack the tar file.  You then decide whether to install it just for you, or for every-
one.  In the first case it will only be available to the user who installs it.  In the second
case it will be available to any user, but will require the root user password to install.
To take the first option, use the command
./installforme.sh

and to take the second option use the command
sudo ./installforall.sh

This will install the QSWAT+ plugin for QGIS, in the user's personal files with the 
first option, and within the QGIS installation with the second option.  It also installs 
the SWAT+ Editor and other tools and data in the SWATPlus directory.  With the first
option, SWATPlus is ~/.local/share/SWATPlus (where ~  is the user's home directory) 
and with the second option it is /usr/local/share/SWATPlus.
There are also shell scripts uninstallforme.sh and unistallforall.sh for uninstalling.

 The TauDEM executables used for watershed delineation by QSWAT+ can run in 
multiprocessing mode, using MPI (Message Passing Interface).  Unfortunately, they 
need MPI to be installed even if the user chooses not to use MPI.  The usual version 
of MPI for Linux is openmpi, and in Ubuntu, for example, running the command

            sudo apt-get install openmpi-bin

in a terminal will install openmpi or tell you it is already installed.

2.3 Mac

 Note that currently QSWAT+ is available for Intel-CPU Macs, not for M1 or M2.

 Obtain QGIS from the download page, selecting Download for macOS, the Official 
All-in-one, signed installers and the Long term release (most stable) version, 
currently 3.28.  This will give you a .dmg file,  Open it, agree to the license, and you 
get a small window with a QGIS symbol and an Applications symbol.  Drag the QGIS
symbol onto the Applications symbol.  This places QGIS in your Applications folder, 
and takes a few minutes.
When you open QGIS in MacOS 10.15 (Catalina) you get a response that it cannot be 
opened because Apple cannot check it for malicious software.  Click the Show in 
Finder button, and then instead of left clicking on QGIS, right click (or hold Ctrl 
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while you click) on QGIS and then choose Open.  The same warning about malicious 
software appears, but this time there is an Open button that you click to start QGIS.  
Thereafter QGIS will open normally.

 The TauDEM software used to do watershed delineation in QSWAT+ is linked 
dynamically to openmpi, so this needs to be installed.  This is most easily achieved by
running in a terminal the command

sudo brew install openmpi

 Install QSWAT+ using the swatplus-mac-installer from the SWAT+ page of the 
SWAT website.  This takes the form of a compressed tar archive.  Save it somewhere,
open a terminal and cd to the directory it is saved in.  Use the command
tar -xvf swatplus-mac-installer.tgz

to unpack the tar file.  cd to swatplus-mac-installer  and use the command
sudo ./installforme.sh

to install for just the user doing the installation.  This needs sudo because it fixes a 
problem in the QGIS installation to properly link some gdalplugins library files. 
This will install the QSWAT+ plugin for QGIS, under the user's home.directory.  It 
also installs the SWAT+ Editor and other tools and data in the ~/SWATPlus directory 
(where ~  is the user's home directory). 
It is also possible to install for all users, with the command
sudo ./installforall.sh 

This installs the QSWAT+ plugin within the QGIS installation, and makes the 
QSWATPlus directory /usr/local/share/SWATPlus.
There are also shell scripts uninstallforme.sh  and uninstallforall.sh for uninstalling. 

2.4 Directories installed
 
The directories created in the SWATPlus directory are:

 SWATPlusEditor containing the editor and the SWAT+ program

 Databases containing a template project database, a reference database, a template 
project file, the global weather generator database (if selected for Windows) and the 
SSURGO/STATSGO soil database (if selected for Windows).

 Documents containing this manual (if selected in the Windows QSWAT+ installer, 
always for Linux and Mac)

 ExampleDatasets containing the Robit example used in this manual

 TauDEM539Bin containing the TauDEM programs used in watershed delineation. 

 Tools containing
o Windows only: ConvertFromArc containing a converter from ArcSWAT 

projects to QSWAT+ projects.  
o SWATGraph (optional in Windows installer) containing 

runSWATGraph_3_16.bat and runSWATGraph_3_22_4.bat (Windows) or 
runSWATGrap.sh (Linux and MacOS) This gives stand-alone access to the 
SWATGraph program.  You should use the first of these if you are using QGIS
3.16 with the .exe installer, and the second if you are using QGIS 3.22 (with 
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the MSI installer).  If your version of QGIS is not 3.16 or 3.22.4 you will need
to edit the setting of OSGEO4W_ROOT on the second line to the correct path 
to QGIS, and if your version is not a long term release you will need to change
qgis-ltr on line 4 to qgis.  You can see which you have by whether you have in 
the QGIS directory the sub-directories apps\qgis-ltr or apps\qgis. 
In MacOS, if your version of QGIS is not called QGIS-LTR.app in 
/Applications, you will need to edit runSWATGraph.sh, replacing QGIS-
LTR.app on line 3 with the appropriate string for your version.

Users can join the QSWAT+ user group at https://groups.google.com/d/forum/qswatplus.  
There are also user groups for the SWAT+ Editor and SWAT+ model.

3 Structure and Location of Source Data

Before starting QGIS, users should prepare their tabular and spatial data according to SWAT+
requirements. Users can refer to Appendix I on preparing tabular data (e.g. preparing soil 
and climatic data). All the spatial data (DEM, land use and soil) should be projected into the 
same projected coordinate system. Users can refer to Appendix II for preparing global data 
for QSWAT+. The example files used in this manual are available in the SWATPlus directory 
in a directory ExampleDatasets/Robit. This directory contains:

 A DEM in directory DEM 

 A stream reaches file to burn in to the DEM, in directory RobitStreams 

 An outlet file in directory MainOutlet

 Landuse and soil maps in directories Landuse and Soil 

 Climate data in directory ClimateRobit 

 Some csv files for making database tables, and

 An observed data file observedFlow.csv  in directory Observed.

Users are recommended to save the location SWATPlus/ExampleDatasets/Robit to your Fa-
vorites or Quick access list in Windows Explorer (In Linux Files use Ctrl-D to bookmark it, 
in Mac Finder drag it to the sidebar). (In Mac Finder you will be looking for /usr/local/
share/SWATPlus and you may not be able to see /usr.  To make it visible, open Finder and 
then use Go in the top menu, select Go to Folder and type /usr in the box.)  There are fre-
quent references to SWATPlus/ExampleDatasets/Robit as files and maps are loaded, and it is 
tedious to access if its path is long.  We shall refer to this folder as Robit   

4 Structure and Location of Output Data

We will be establishing a project called Demo1 in a folder QSWATPlus_Projects/Robit. (On 
Windows you might create C:\QSWATPlus_Projects;  in Linux or Mac you will perhaps 
create QSWATPlus_Projects in your home folder.) This will create:
1 A folder QSWATPlus_Projects/Robit/Demo1 called  the project folder.
2 A file QSWATPlus_Projects/Robit/Demo1/Demo1.qgs  called the project file.  This 

contains details of the current state of QGIS, and the project settings we have chosen. 
If we later want to reopen the project Demo1.qgs will be the file we look for..
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3 A folder QSWATPlus_Projects/Robit/Demo1/Scenarios/Default/TxtInOut that will 
contain all the SWAT+ input and output files.

4 A folder QSWATPlus_Projects/Robit/Demo1/Scenarios/Default/Results that may be 
used by the SWAT+ Editor and is used to hold results files from visualisation.

5 If we choose to save a SWAT run as Sim1, say, then a folder 
QSWATPlus_Projects/Robit/Demo1/Scenarios/Sim1 will be created (a copy of 
QSWATPlus_Projects/Robit/Demo1/Scenarios/Default, including its sub-folders).

6 A folder QSWATPlus_Projects/Robit/Demo1/Watershed with several sub-folders:
6.1 Rasters to contain the rasters used, divided into 3 further subfolders

6.1.1DEM which will contain the local copy of your DEM, plus all the files 
generated from it like flow direction, streams and subbasins as rasters

6.1.2Landscape which will contain, if you create floodplains, floodplain rasters 
and the rasters created to generate them.

6.1.3Landuse to contain the local copy of your landuse raster
6.1.4Soil to contain the local copy of your soil raster

6.2       Shapes to contain all the shapefiles used or generated
6.3      Text to contain reports.

5 Setup for Robit Watershed, Lake Tana Basin

The remainder of this document describes and shows tools as they appear in Windows.  Linux
and Mac versions of QGIS will look almost identical.  It will be assumed that users know 
how to do common tasks like create directories in Linux and MacOS, or can use the internet 
to find out.

Start QGIS and select Plugins menu -> Manage and Install Plugins and find 
QSWATPlus3_9 (or QSWATPlus3_64 if that is what you installed).  Click its checkbox 
to install, which takes a few seconds. The QSWAT+ icon will appear in the toolbar.

Figure 1: QGIS 3 with the QSWAT+ plugin loaded

You should also check that the Processing plugin is checked in the Plugins menu.  This is a 
standard part of QGIS and should be activated by default, but may not be.  You can tell if it is 
activated by whether Processing appears as a menu item at the top of the QGIS window, as it 
does in Figure 1.

Start QSWAT+ by clicking the QSWAT+ icon.  The main QSWAT+ interface will be 
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displayed.. 

Click the box New Project. A browser will be displayed requesting a parent directory for the 
new project. Browse to a folder such as C:\QSWATPlus_Projects.  You will probably need to 
create the folder Robit, so in the left panel right click on QSWAT_Projects to open a menu, 
select New -> Folder and type in Robit to overwrite the default name of New Folder, and hit 
Enter.   Robit will appear in the right panel.  Select it so it appears in the text box below and 
click Select Folder.

A new form opens asking for the project name, which must start with a letter.  Type in Demo1
and click OK.

The interface now presents a step-by-step configuration to be followed in order to prepare the
SWAT+ simulation, starting with Step 1 (Figure 2).  Note that it displays the path of the 
project folder at the foot.  The QSWAT+ Parameters and Export Table buttons are 
described later in sections 11 and 12.

Figure 2: QSWAT+ interface at step 1

At this stage the project database is created as Demo1.sqlite in the project folder, and a copy 
of the SWAT reference database swatplus_datasets.sqlite is also created there. 

At this stage all your maps should be prepared in an equal area projection (probably, but not 
necessarily, UTM1). All the maps should be in the same projection coordinate system. Refer 
to Appendix II – preparing global DEM data for QSWAT+ for advice on preparing DEMs.

1  UTM is not an equal area projection, but is close to being so, and sufficiently close for SWAT+ to use on 
most watersheds.
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6 Watershed Delineation

6.1 Loading the DEM

To start automatic watershed delineation click the Delineate Watershed button. Then click 
the button in the Select DEM group.

Browse to the Robit/DEM/srtm_30m folder and open the file hdr.adf. This DEM is an ESRI 
grid (or raster) and consists of a number of files. The file called hdr.adf is the one to choose 
for such a grid.  QSWAT+ accepts a very wide range of raster file formats.  The most 
common are probably GeoTiff files, which normally have a .tif  suffix and come as single 
files.

Figure 3: Selecting the DEM

The name of the elevation map grid will be displayed in the DEM text box below the 
Watershed dialogue box. The selected DEM will be copied to the projects Source folder and, 
if necessary, converted to GeoTiff format (.tif). If your DEM's units are not metres you can 
select the DEM properties tab and change them. This tab also shows the DEM cell size, cell 
area, projection system and extent in degrees. 
Users can burn in using an existing stream network using the option Burn in existing stream
network: use a file with the extension *.shp (Figure 4).  Check the Burn in existing stream 
network option and select the file Robit/RobitStreams/robReach.shp.

The delineation form allows you to opt for a predefined watershed and stream network by 
selecting the Use existing watershed tab. If you are interested in using a predefined 
watershed and stream network please refer to Appendix III: Using a Predefined Watershed
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and Channel Network). 

We will not use MPI, which enables multiprocessing during watershed delineation (see
Appendix IV:  Installing and Using MPI) and so the Number of processes spinbox should 
be set to 0.

Figure 4: Creating the stream network

6.1.1 Creating channels and streams
The threshold sizes for creating channels and streams should be set next. They can be set by 
area, in various units such as sq km or hectares, or by number of cells.  If necessary, change 
the threshold method to use hectares, change the area for channels to 9 and for streams to 90, 
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and press Create Streams: the number of cells will be adjusted to the corresponding value 
(100 and 1000 respectively). The threshold is the number of cells (or area) required to form a 
channel or a stream: a cell will be made part of a channel or stream if it has at least the 
threshold number of cells draining into it. Stream reaches are sections of the stream network 
between significant points, where significant points are stream sources, monitoring points 
like water gauges, stream junctions, inlets, and watershed outlets.  A subbasin is an area 
draining into a stream reach. Subbasins are the main divisions of the watershed, and typically 
the entities whose SWAT outputs we will want to generate and study.  Channels are finer 
divisions and extensions of stream reaches, and allow us to place more precisely the 
components of the watershed which will form the SWAT+ model: landscape units, reservoirs,
ponds, point sources, and hydrological response units.  This step creates streams (Figure 5). It
also loads the stream burn-in shapefile if one was selected.  

Figure 5: Stream and channel networks displayed

6.1.2 Inlets and outlets
An inlets/outlets file containing just a main outlet is provided for this example. Check the Use
an inlets/outlets shapefile option, and browse to Robit/MainOutlet/MainOutlet.shp.  The 
outlet is added (Figure 6).

Users can add outlets, reservoirs, ponds, inlets, and point sources by selecting the Draw 
Inlets/Outlets option. This first asks if you wish to add to the existing inlets/outlets file, or 
create a new one. Having made this choice, select the type of point to add, and click on the 
map to place it at the appropriate place. Inlets and outlets need to be placed on the stream 
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network, so you will need to make streams but not channels visible first.  You may need to 
zoom in to place them precisely. Point sources, ponds and reservoirs need to be placed on the 
channel network.  Only points within the snap threshold (default 300 metres) of a stream (or 
channel) reach will be counted as points. Click OK to confirm and exit, and Cancel to 
remove points and exit. If you choose to draw a new file, drawoutlets.shp is created in the 
Watershed/Shapes folder, which may be used again. See Appendix III: Using a Predefined 
Watershed and Channel Network for details of the fields needed in an inlets/outlets file.  
We do not add any additional outlets, ponds, reservoirs, inlets, or point sources in this 
example.
  

Figure 6: Outlet added

If you have several points in your inlets/outlets file you can choose to use just a selection of 
them. To do this choose the Select Inlets/Outlets option. Hold Ctrl and select the points by 
dragging the mouse to make a small rectangle around them. Selected points will turn yellow, 
and a count will be shown at the bottom left of the main window. You only need to use this 
option if you want to use only a subset of outlets.  The default is to use all the points in the 
outlets file or those drawn.

You will be told how many points were snapped successfully.  If some were not snapped (or 
to check in advance before creating the watershed), you can click Review snapped which 
shows the snapped inlets/outlets, i.e. those within the defined threshold distance. 
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Clicking Create Watershed will create the watershed (Figure 7).  Check that the delineation 
form shows the right number of points have been snapped (in our case 1) and none have 
failed.  Note that in Figure 7 we have zoomed in a little to focus better on the watershed.  
This is done by selecting the subbasins layer in the Layers  panel and then clicking the Zoom
to layer  button (in the top tool bar, just under Processing).

Figure 7: Delineated watershed

In QSWAT+ it is possible to divide subbasins into landscape units.  Two landscape units are 
possible, floodplain and upslope.  If we define landscape units, when we later come to define 
hydrological response units (HRUs) these will be defined within each landscape unit, and if 
we also choose to select only some HRUs, then each landscape unit will be treated separately,
so that each landscape unit contains at least one HRU.  The choice of defining landscape units
applies to the whole watershed.  It is possible that very small subbasins might fall wholly 
within the floodplain, but in general each subbasin will have two landscape units.

6.1.3 Creating landscape units
To define landscape units, we click the Create landscape tab and then the Create button.  
This brings up the Landscape analysis form (Figure 8).
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Figure 8: Creating landscape units by buffering streams

There are three possible methods for creating landscape units.  The first is to make the 
floodplain simply as a buffer drawn around the stream reaches.  There is no terrain analysis 
involved.  The width of the floodplain on each side of the stream is set as a multiple, default 
10, of the stream width.  Main stream width varies with the area draining to it, so the 
floodplain width will also vary, increasing downstream.  This method is most likely to be 
used when the terrain is mostly flat, when other methods can give poor results.

The second method is called DEM inversion.  It is calculated by negating all the DEM 
elevations and recalculating flow directions, and calculating how much water would then 
flow into each point, the flow accumulation.  Points where the flow accumulation exceeds a 
threshold, the ridge threshold, are designated as ridges.  This exactly mirrors the method of 
calculating where streams will occur, and the default ridge threshold is set the same as the 
stream threshold.  A slope position for each point is then calculated.  This is the ratio of the 
drop from each point to where its water flow meets a stream, to the total drop from its ridge 
point (where its inverse flow meets a ridge) to the same stream point.  If this ratio is less than 
the slope position threshold its landscape position is floodplain, else it is upslope.  0.1 is a 
typical value to use for slope position, and is the default (Figure 9)
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Figure 9: Creating landscape units by inverting the DEM

The third method of creating landscape units is the branch length method.  This uses the same
slope position method, but a different method for defining ridges.  We can calculate the 
branch length of any pair of adjacent points as the lesser of the distances from each point to 
where their flow paths meet (which may be infinite if these paths go to different watershed 
outlets).  A point is said to be on a ridge if it has a branch length with an adjacent point which
exceeds a threshold.  Then for each point in the watershed we use for its stream point where 
its flow path meets a stream, and for its ridge point the nearest point classified as on a ridge, 
and calculate its slope position as with DEM inversion.  Users should note that the branch 
length method takes perhaps an order of magnitude longer than DEM inversion to calculate.

Since it is not clear what method will be best for any particular watershed, the choice needs to
be made by the user, and is probably best made visually.  The interface therefore allows for 
several versions of possible landscape units to be made, and then one to be chosen later when 
HRUs are created.  To this end, landscape unit rasters show just the floodplain, and are given 
the name bufferfloodn if created by buffering, where n is the buffer multiplier, invfloodn_m if 
created by DEM inversion, where n.m is the slope position threshold, and branchfloodn_m if 
created by the branch length method.  Users can therefore if they wish create several 
candidates, using different methods and/or different parameters.  Figure 10 shows the result 
of creating three using each of the methods with the default parameter settings, and making 
only the third currently visible in the map canvas.  For this exercise you should create the 
same three floodplain rasters.  Click Done  to close the Landscape analysis form.
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Figure 10: Potential floodplain rasters created

6.1.4 Merging subbasins

In QSWAT+ users can select and merge subbasins. This is especially important in avoiding 
small subbasins. To merge subbasins, select the option Select subbasins in the Merge 
subbasins tab. Hold the Ctrl key and click in subbasins you want to select. Selected 
subbasins will turn yellow, and a count is shown at the bottom left of the dialogue window 
(Figure 11).  
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Figure 11: Subbasin identified for merging

For the sake of this exercise, we will not merge the selected subbasin. Release the Ctrl key 
and click on the map outside the watershed and the selected subbasin will be unselected. 
Checking the option of Select small subbasins provides the option to merge subbasins below
a certain threshold (i.e. either the area in hectares or a percentage of the mean subbasin area) 
(Figure 12). For this exercise click the radio button percentage of mean area, and leave the 
default figure of 5 in the box next to it. Click Select. It will show you subbasins that have an 
area less than 5% of the mean area. When finished click “Save” to save your selection, or 
“Cancel” to abandon your selection. You click Merge to perform the merge. Note: You 
cannot merge a subbasin that has an outlet or inlet at its exit.  So in this example, the only 
small subbasin is the one at the watershed outlet, which cannot be merged, and QSWAT+ will
report this.
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Figure 12. Subbasins that have an area less than 5% of the mean subbasin area intended for merging with
downstream subbasins.

The third tab in the delineation form is to Add Lakes.  We have no lakes to add in our Robit 
example, and it is a substantial topic, so we will return to it later in section 10.

To complete watershed delineation you need to click OK. This calculates and saves 
information about the watershed, with the message Constructing topology,  and causes the 
subbasins to be numbered. This step ends watershed delineation, and enables the Create 
HRUs option (Figure 13).
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Figure 13. Watershed delineation is completed, and Create HRUs is enabled

6.2 Create HRUs

6.2.1 Landuse and soil maps

Having calculated the basins you needed to calculate the details of the Hydrological 
Response Units (HRUs) that are used by SWAT+. These are divisions of basins into smaller 
units each of which has a particular soil/landuse (crop)/slope range combination.

To do this we click Create HRUs, which opens the Create HRUs form and shows the first 
tab, Landuse and soil.  The second tab, HRUs, will become available when we have read the
landuse and soil files and established for each pixel in our watershed values for landuse, soil 
and slope, as well as assigning it to a landscape unit and to a subbasin.

Select Robit/Landuse/roblandusenew/hdr.adf as the Landuse map, and select 
Robit/Soil/mowr_soil90/hdr.adf as the Soil map.  You may notice that the landuse map is 
loaded as selected, as an ESRI raster with a name hdr.adf.  But the soil map, instead of being 
mowr_soil90/hdr.adf is called mowr_soil90_clip.tif.  This is because QSWAT+ checks to see 
if landuse and soil maps are substantially bigger than the DEM (at least 10 DEM pixels in 
any direction) and if so clips them to avoid loading a larger map than necessary.  The clipping
also converts them to GeoTiff format.  So when preparing such maps for QSWAT+ you need 
to make sure their projection matches the DEM, and that they easily cover the watershed 
area, but do not worry about clipping them to size

We need lookup tables to convert from the numeric values found in the landuse and soil maps
to SWAT+ landuse codes and soil names respectively.  These lookup tables must be in the 
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project database.  You can prepare these in advance, or use predefined ones like 
global_landuses  and global_soils  intended for use with the corresponding global maps, or, 
as we will do here, use the option to import a comma separated values (.csv) file.  Lookup 
tables for landuse must have the string landuse in their names; lookup tables for soils must 
have the string soil in their names, or they will not appear in the pull-down menus Landuse 
table and Soil table respectively.

For landuse, select the option Use csv file in the Landuse table pull-down menu.  A form 
appears asking for the landuse lookup csv file.  Browse to Robit/Robit_landuses.csv and click
Open.  This reads the csv file and makes a table Robit_landuses in the project database.  The 
csv file has the appropriate structure for a landuse lookup table.  Its contents are shown in
Figure 14.  The first line, commonly included, is ignored if its first field is not numeric.  On 
each other line, the first field, delimited by a comma, is a value from the landuse map.  The 
second field is a SWAT+ landuse code, as found in one of the tables plant or urban in the 
project database, or as defined by the user in a new table.  Optionally, a third column with 
heading DESCRIPTION can be included, and a third text field (possibly empty, but preceded 
by a comma) included on each following line.  More than one map value may map to the 
same landuse code, but map values may not be repeated.  The table name is determined as 
follows.  First, if the file name contains landuse (as ours does) it is used as the basis.  
Otherwise landuse_lookup is used as the basis.  Second, if the basis does not exist as a table 
name it is used, otherwise successively 0, 1, etc is appended until an unused table name is 
found and used.  In our case Robit_landuses will be the table name. You will not need to read 
the csv file again: if you rerun the project, Robit_landuses will be available in the pull-down 
menu (and will be the default selection as it will be recorded in the project file as the landuse 
lookup table). 

Figure 14: Robit_landuses.csv

The SWAT+ landuse codes are usually to be found in the tables plant or urban in the project 
database, but users are free to set up their own tables.  First, they can change the landuse and 
soil database from its default of the project database to another database.  Second, the plant or
urban table need not use that name: the pull down menus labelled Plant table and Urban 
table will include any tables with plant or urban respectively in their names.  Users can also 
use the Use csv options in these menus to load a csv file with the appropriate data and create 
a suitable table.

For grid models, where grid cells may contain only a few landuse cells, there is a danger that 
nodata landuse cells could cause the whole grid cell to have no landuse value.  To avoid this, 
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nodata landuse values are replaced by a default value.  The default value is the value mapped 
by zero in the landuse lookup table, else the first one read.  Since the order of entries in 
database tables is arbitrary, it is a good idea to include 0 in lookup tables if you are creating 
grid models.

For soil, similarly select Use csv file, and then open Robit/Robit_soils.csv.  It maps values 
from our soil map to soil names found in the SNAM  field of the usersoil table we are about to
create.  

6.2.2 Defining soil properties

Unless our project is in the USA and we are using SSURGO or STATSGO, we also need a 
table describing soil properties.  This traditionally has a name  usersoil, or one including that 
name, and is typically to be found in the project database.  These are the defaults currently in 
the form for the database and the table name.  You can change the database if you have your 
soil data in some other SQLite database, (but it must include your plant  and urban tables as 
well) and you can use any table with usersoil in its name.  The default global_usersoil in the 
project database is appropriate for the global soils maps from the FAO, but not in our case.  
Leave the default landuse and soil database selection as it is (the project database), make sure
the Soil data option is set to usersoil, and select Use csv file in the Usersoil table pull-down 
menu.  Open . Robit/Robit_usersoil.csv to create and select the table Robit_usersoil.

The other Soil data options are for watersheds in the USA for which you are using 
STATSGO, STATSGO2, or SSURGO soil maps. If you select the STATSGO  or the 
SSURGO/STATSGO2 option then soil data will automatically be extracted from the 
swatplus_soils.sqlite  database stored in SWATPlus/Databases. No soil lookup table is needed
with  SSURGO/STATSGO2.  For STATSGO, a lookup table is required, and it will map soil 
map values to one of four options, all based on the table statsgo in swatplus_soils.sqlite:

1 muid  values such as AL001
2 muid+seqn values such as AL001+1
3 muid+name values such as AL001+DICKSON
4 s5id  values such as TN0042

The lookup table must use one of these options consistently.  Where lookup target matches 
more than one row in the statsgo table the first (as ordered by increasing id values) is taken.  
So the four examples above would all give the first row (id 1) in the table.

We will use one of the floodplain maps we created earlier, to divide our subbasins into 
landscape units.  Use the pull-down menu labelled Select floodplain map (optional) to select
invflood0_10.tif.  This menu will include all files found in the project's 
Watershed/Landscape/Flood folder: you can add such files yourself if you wish.  They need 
to be rasters with the same projection as the project, and must have the value 1 for floodplain 
pixels, and nodata everywhere else.  If you do not select from this menu. no landscape units 
will be created.  If you place your own flood maps in this folder you should not include the 
string flood in the their names, since such files will be removed by watershed delineation.  
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Floodplain maps created by QSWAT+ need to be recreated after rerunning delineation 
because they are based on the channel network, which is likely to change when delineation is 
rerun with different parameters or with changed inlets or outlets.

We will form HRUs based on slope as well as landuse and soil. We add an intermediate point 
for slopes (e.g. 10) to divide HRUs into those with average slopes in the range 0-10% and 
those with average slopes above 10%. Type 10 in the box and click Insert. The Slope bands 
box shows the intermediate limit is inserted.

We will also generate a  FullHRUs shapefile: click in the check box.  Generating this file is 
optional, as it can take some time if there are many HRUs.  If you intend to visualise HRU 
outputs after running SWAT+ then you need to generate this file.

To read in the data from the DEM, landuse, soil and slope maps and prepare to calculate 
HRUs, make sure Read from maps is checked and click Read (Figure 15). There is also an 
option Read from previous run. This can be used when rerunning the project, provided you 
have not rerun the delineation step, and not changed the soil or landuse inputs, or the slope 
bands, to recover information from the project database instead of rereading the grids. 
Reading from the database is substantially faster. 
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Figure 15: Ready to read landuse and soil files

After reading the grids you will notice a number of changes to the QGIS display (Figure 16):
 A Slope bands map has been created and added. This allows you to see where the 

areas of the two slope bands selected for this project are located. If no intermediate 
slope limits are chosen this map is not created.

 The legend for the landuse map robelandusenew includes the landuse categories from 
its lookup table.  (This should also happen for the soil map, but in this case there is 
apparently a very wide range of values, from 106 to 198, but QGIS does not recognize
that only 4 values actually occur.).
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 Shapefiles Full HRUs and Full LSUs have been created and added. This allows users 
to see where in each subbasin the landscape units (LSUs) and potential Hydrological 
Response Units (HRUs) are physically located. A landscape unit is the region draining
into a channel reach, further divided into the floodplain and upslope regions if a 
floodplain raster is used.  LSUs form single regions: they each form a single polygon. 
An HRU is the collection of pixels within an LSU that share the same landuse, soil 
and slope range.  HRUs typically form a collection of polygons.  If, for example, we 
zoom in on subbasin 3, in the Legend panel select (left button) Full HRUs, open its 
attribute table (right button), set the mouse to Select Feature(s) (QGIS toolbar, or use 
View -> Select -> Select feature(s)) and click on the south-east of subbasin 3, then 
scroll through the attribute table to find the line selected, then we get a view like
Figure 17. We see that this potential HRU is composed of several parts, is in subbasin 
3 as we expected, drains to channel 57, has the landscape unit Upslope, landuse 
AGRL, the soil LVx, and the slope band 10 upwards. Its area of 18.45 ha is 5.4% of 
the subbasin and 59.9% of the channel's upslope landscape unit. Close the Attribute 
Table Editor. Generating the FullHRUs shapefile is optional, as it can take some time, 
but is necessary if you intend later to visualise HRU results. Counts of the subbasins 
(9), channels (87) and full (potential) HRUs (516) are displayed in the Create HRUs 
form whether the FullHRUs file is created or not. 

Figure 16: After reading grids
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Figure 17: Viewing a particular HRU

Before you continue with HRU definition, if you look at the main QSWAT+ window you see 
that a new item Select report to view is available and you can choose to view just two 
reports at this point, which are the Elevation and Landuse and Soil reports. The elevation 
report gives information about how much land is at each elevation from the lowest to the 
highest, both for the watershed as a whole and for each subbasin (Figure 18). The landuse and
soil report lists the landuse, soil and slope-band areas for each subbasin (Figure 19).  It also 
lists the areas, divided into landscape units if these are in use, for each channel reach.
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Figure 18: Elevation report
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Figure 19: Landuse and soil report

6.2.3 Merging short channels

It often happens that although we set a certain threshold for the area needed to form a channel
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(9 hectares in our case), channel reaches within the network can be very short, because 
junctions happen to be near each other, and their drainage areas correspondingly small.
Figure 20 shows a channel reach in subbasin 3 only 72.4 metres long with a drainage area, 
landscape unit (LSU) number 121 (highlighted in yellow) of only 0.54 ha.  This is in fact 
divided into 2 potential HRUs, one of only 0.09 ha!  Such HRUs are best removed because 
SWAT+ will spend time processing them but their effect will be insignificant.  We will later 
be removing small HRUs, but there is a rule that each channel reach, and indeed each 
landscape unit if we use them, will retain at least one.   To counter this there is an option to 
merge short channels into neighbouring ones, by selecting a threshold either as a percent of 
subbasin or as an area in hectares, and recreating the channel network.  Use the slider in the 
Short channel merge group (or type in the box) to set the threshold at 2%, select the Re-merge
short channels option and click Read again.  We see that the channel count drops to 72, and 
the full HRUs count to 4552.  If we inspect the landuse and soil report for subbasin 3, we see 
that the smallest channel drainage area now is 2.62% of the subbasin, with a drainage area of 
9 hectares.  If we still think this too small we can change the short channel threshold and 
click Read again.  But we will continue with the setting we have.  The short channel merge 
threshold can be set before the first Read if you wish.  

Figure 20: Small channel reach and its drainage area

6.2.4 Preparing to create HRUs

2  HRU counts may differ slightly on different machines
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Completion of reading from maps, or reading from previous run, enables the second HRUs 
tab in the Create HRUs form, and we select it (Figure 21).  This will enable us to create the 
actual HRUs to be used in the project, usually a selection of the full HRUs.

Figure 21: ready to create HRUs

6.2.5 Splitting and exempting landuses

At this point you have the options to split landuses, and to exempt landuses, both of which 
will affect how HRUs are defined.

 Splitting landuses allows you to define more precise landuses than your landuse map 
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provides. If, say, you know that in this basin 50% of the AGRL (Agricultural land 
generic) is used for corn, and the other 50% is used for teff, you could split AGRL 
into 50% CORN and 50% TEFF (Figure 22). It is possible to use the original landuse 
(here AGRL) as one of the sub-landuses. The percentages are integers and need to 
sum to 100 for each landuse you split. Split AGRL into 50% CORN and 50% TEFF as
shown.  To do this, first select AGRL in the Select landuse to split pull down menu. 
This immediately raises a Select sub-landuse form.  Select CORN and click OK.  
This completes the first line of the table.  Click the Add sub-landuse button, select 
TEFF and click OK.  This adds the second line.  Then change the two percentages to 
50, Click Save edits to store the contents of the table as a split landuse, and finally 
click Save splits to complete the form and exit from it.

 Exempting landuses allows us to ensure that a landuse is retained in the HRU 
calculation even if it falls below the thresholds we will define later. For example, we 
might decide to exempt the forest landuse FRST (Figure 23). Make this exemption.

Figure 22: Splitting a landuse
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Figure 23: Exempting a landuse

6.2.6 Ponds and reservoirs

There are 3 ways in which ponds and reservoirs may be formed in QSWAT+:
1 Lakes can be added, and these must be designated as ponds or reservoirs (or 

wetlands).  See section 10.
2 Points can be identified as pond or reservoir points in the inlets/outlets shapefile.  In 

this case each such point must be within snapping point of a channel.  The channel is 
divided at the snap point into two, the downstream portion remaining as a channel and
the upstream portion becoming a pond or reservoir.  Any pixels with landuse WATR 
in the adjacent LSU become part of the pond or reservoir, instead of potentially 
becoming HRUs.  Here the channel's adjacent LSU is the floodplain LSU if a 
floodplain map is selected, else the whole LSU.

3 A reservoir threshold percentage can be set.  This is the minimum percentage of 
WATR in the adjacent LSU for the WATR area to become a reservoir.  When this 
threshold is met, the channel is replaced by a reservoir, with area the WATR area of 
the adjacent LSU.  The default threshold is 101%, effectively turning off the 
automatic creation of reservoirs.  If we change the threshold at this point we will need
to re-read the data from the landuse, soil and slope maps: Read from previous run is 
selected and the HRU creation options are disabled until we click Read again.  The 
short channel merge setting is retained (or can be changed) and will be reapplied.   
Connected channels which meet the threshold for forming automatic reservoirs will 
form a single reservoir.  The exception to this is when a pond or reservoir has been 
marked on a channel during delineation.  The pond or reservoir's position prevents it 
being combined with a reservoir downstream.  This gives users a means to control the 
otherwise automatic merging of reservoirs.

Channels which become ponds or reservoirs effectively disappear from the routing (water 
flow) network.  Channels, landscape units and HRUs that would normally be routed to them 
are routed to the pond or reservoir instead.
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This watershed has no WATR areas and so no reservoirs or ponds could be formed, even if 
we reduced the reservoir threshold.

6.2.7 Creating HRUs

Once all the data has been read in and stored, the Single/Multiple HRUs choice is enabled. 
Dominant landuse, soil, slope and Dominant HRU options provide just one HRU for each 
landscape unit (i.e. each is a single HRU option). Dominant landuse, soil, slope chooses the 
landuse with the biggest area in the landscape unit, the soil with the biggest area in the 
landscape unit, and the slope range with the biggest area in the landscape unit and uses them 
for the whole landscape unit. Dominant HRU selects the largest of the potential HRUs in 
each landscape unit and makes its landuse, soil and slope range the ones chosen for the whole
landscape unit.  

The options with Filter by landuse, soil, slope; Filter by area; and Target number of 
HRUs create possible multiple HRUs in each landscape unit. For the Multiple HRUs option,
users can exclude HRUs that are insignificant by considering percentage thresholds or area 
thresholds. The option of Filter by land use, soil and slope, will ignore any potential HRUs 
for which the landuse, soil or slope is less than the selected threshold. The areas of HRUs that
are ignored will be redistributed proportionately amongst those that are retained within each 
landscape unit. The option of Filter by area will ignore HRUs that are below a specified 
threshold amount (either percent of the landscape unit, or area). Finally the option of Target 
number of HRUs limits the number of HRUs in the whole watershed to a user preferred 
amount (i.e. between the lower limit of one HRU per landscape unit and the upper one of 
retaining all potential HRUs).   

For this exercise, use the method of Filter by land use, soil and slope and choose the 
Threshold method of Percent of landscape unit. For landuse, the value of 51 as the 
maximum we can choose indicates that there is a landscape unit where the maximum value 
for a landuse is 51%. If we chose a higher value than 51% we would be trying to ignore all 
the landuse categories in that landscape unit.  Hence 51% is the minimum across the 
landscape units of the maximum landuse percentage in each landscape unit.  For this exercise,
select 10% for landuse, by using the slider or by typing in the box, and click Go. The 
interface then computes the min-max percentage for a soil as 51%.  Select 10 for Soil, click 
Go. Similarly select 10 for slope. At this stage the user can create HRUs by clicking Create 
HRUs (Figure 24). The number of HRUs created (651) is reported at the top of the map 
canvas.  (This figure is higher than the FullHRUs count (455) reported earlier because of the 
splitting of AGRL HRUs.)
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Figure 24: Creating multiple HRUs by Filter by land use, soil and slope

Create HRUs is now reported as done and the third step is enabled (Figure 25). A file Actual 
LSUs has been added and, if you requested a Full HRUs file, an Actual HRUs file has also 
been added. These contain the actual LSUs after any channel merges, and the potential HRUs
that were retained as actual HRUs (and so typically has some holes representing those that 
were not retained). The actual LSUs shapefile attributes table shows the LSU identifiers, the 
channel and the subbasin.  The actual HRUs shapefile attribute table shows the subbasin and 
channel, the landscape category, (original) landuse, soil, and slope band, and the HRU 
number(s).  In the case of split HRUs there can be more than one HRU number for a shape, 
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as it is impossible to show in a shapefile the splitting by arbitrary amounts of the original 
potential HRUs.  If you look at the Reports now available you will find that there is an HRUs 
report that only includes the landuses, soils and slope bands  left after HRU selection, and 
also gives details of the HRUs that have been formed (Figure 26). If you wish to change the 
HRU thresholds then you can click the Create HRUs button again, select Read from 
previous run, click Read, change the thresholds and/or the landuses to be split or exempted, 
and rerun the Create HRUs step.

Figure 25: About to do step 3
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Figure 26: HRUs report

A new shapefile has been added, title Channel reaches.  This is formed from the channels 
shapefile created during delineation, but has channels merged.  Another shapefile, showing 
the point sources that are automatically added to each channel, and any reservoirs that were 
added, has also been added.  A point source is added to every channel as a convenience.  
Users can add data (in the SWAT+ Editor) for any point sources they want to include in their 
model: point sources without data are ignored.

It is strongly recommended to save the project (via the file menu of QGIS) at this stage.

You are now able to click the Edit Inputs and Run SWAT button to start the SWAT+ Editor,
set the rest of the parameters and input data you need, and run the SWAT+ model.  This 
document does not cover the editor - you need to consult the SWAT+ Editor documentation 
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for details, but there are a few things you need to know about how to run the Robit example.  
Check the next subsection before starting the editor.

6.3 Setting up the Robit example in the SWAT Editor

Before starting, you can prepare weather generator information.  The Robit example data 
includes such data in the Robit directory, and no more preparation is required.

Second you will need (if you have it) to supply observed weather data.  The Robit example 
data includes such data, in Robit/ClimateRobit, and no more preparation is required.

After starting the editor (Figure 27), click Start to import the project and reference databases.
Then on the project summary screen (Figure 28) click Get started, and then on the next 
screen Add weather generators now.

Figure 27: SWAT+ Editor start
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Figure 28: SWAT+ Editor project summary

6.3.1 Weather data

To set up the weather generator, click Import data  and select CSV files  as the data format.  
Browse to Robit/WGEN_Robit_stat.csv  as the Stations csv file, and  
Robit/WGEN_Robit_mon.csv  as the Monthly values csv file.  Check the box to state that 
you have observed weather data and click Start (Figure 29).  
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Figure 29: Importing weather generator data

The weather data generator data is imported and you will see a single row since there is only 
a single station in this data (Figure 30).
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Figure 30: Weather generator data imported

With the weather generator set up, select Weather stations at the top left.  In the Weather 
Stations form click Import data.  The Robit observed data is in the SWAT2012 format, so 
leave this as the choice in the first box.  For the weather files directory, browse to select the 
folder Robit/ClimateRobit.  For a directory to save the files you can choose anywhere you 
like, but the default of the Scenarios/Default/TxtInOut folder, where other input files will be 
stored, is a sensible choice..  Click Start (Figure 31).  
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Figure 31: Importing observed weather data

The Weather Stations form will reappear, showing a single station with data for precipitation, 
temperature, solar radiation, relative humidity and wind speed (Figure 32).
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Figure 32: Observed weather data imported

6.3.2 Simulation period

Click the triangular symbol on the left for Run SWAT+, which opens the simulation settings 
page (Figure 33). 
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Figure 33: Simulation settings

Under simulation settings the folder for the SWAT+ input files can be left as the default.  
Select Set your simulation period.

We have daily data for the beginning of 1990 to the end of 2013, but to keep down the time 
needed to run and to import the output data we will restrict the period to 1990 to 2000.  Use 
the date picker to change the ending date to 31 December 2000.  Note you can adjust the year
forward or backward by decades as well as years.  After selecting the year you need to click 
on the day (31 December) for the change to register (Figure 34).
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Figure 34: Setting the ending date of simulation

6.3.3 Print options

Select Choose output to print. .  We will use 3 as the warm-up period.  SWAT+ will run for 
the first three three years, but the output will be ignored.  

For the objects to print, some output is preselected.  We will visualise a variety of outputs, so 
select just three of the top boxes under Monthly, Yearly and Average.  Then find and add 
channel under Daily, which we will need for calculating environmental flows.  We won't 
include other daily output as it will take some time to write nearly 3000 records for each 
channel, lsu or hru in requested output (Figure 35). 

47



Figure 35: Setting print options

6.3.4 Run SWAT+

Scroll down and make sure Write input files, Run SWAT+, and Analyze output for 
visualization  are all checked (Figure 33).  We don't need the debug version, which you 
would normally only use if the model has errors, to get more information.  Click Save 
Settings & Run Selected.    We see the input files being written, then SWAT+ running, and 
the output files being read.  They are being stored in an output database, 
swatplus_outputs.sqlite  in the Scenarios/Default/Results  folder.   We selected a lot of 
outputs, so this takes a few minutes.  When it is finished we can Exit SWAT+ editor.

7 Output Visualisation with QSWAT+ 

Once SWAT+ has been run and the output imported, so that there is an output database 
swatplus_output.sqlite in the Scenarios/Default/Results directory of the project, then a button 
Visualise becomes available in the main QSWAT+ form (Figure 36). Visualisation allows 
outputs from SWAT+ to be visualised graphically.
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Figure 36: Main QSWAT+ form showing Visualisation button

7.1 Running visualise

Click Visualise on the main QSWAT+ form to bring up the Visualise Results form (Figure 
37).  Here the Choose scenario pull-down menu shows the simulations, or scenarios, that are 
available, currently only the Default one.  Select the one that you wish to display. Then use 
the Choose SWAT+ output table to see what tables are available.  This depends on what you
chose to print in the SWAT+ Editor, and for HRU results on whether a FullHRUs shapefile 
was generated3.

7.2 Visualisation period

The start and finish dates shown are initially the start and finish dates of output from the 
Default scenario. Note that the initial year is 1993 since we simulated from 1990 but set 
nyskip to 3.  You may choose dates within these if you wish, to shorten the period being 
visualised.  If other scenarios are selected, the dates will be changed if necessary to ensure 
there is data available for the whole period.

7.3 Static visualisation

There are three possibilities shown by the tabs for Static data, Animation and Plot. For 
static data a single summary value is calculated for each aquifer, channel, HRU or LSU and 
displayed as a map. For animation there is an animated display of the value in each aquifer, 
channel, HRU or LSU at each time step in the animation. Plot supports the creation and 
display of plots of selected variables. This section deals with static data: animation and 

3  HRU tables (those with names starting  'hru_') are available for plotting, but not for static visualisation or 
animation unless a  FullHRUs file was generated.  Rather than repeating this warning many times,  we 
assume in the rest of this section that the FullHRUs shapefile was generated.
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plotting are described in the following sections. Make sure the Static data tab is selected.

Static results are created by generating a shapefile, and by default this will be called 
<table>results.shp (e.g. lsunit_pw_monresults.shp) and stored in the Results directory of the
current scenario. You can leave this default, or change the file name and location as you wish.
You may notice files called hrus.shp, lsus.shp, rivs.shp, subs.shp, aquifers.shp and 
deep_aquifers.shp in this directory. Do not choose any of these as your file name: the first 
four are copies of the actual HRUs, LSUs, channels and subbasin shapefiles generated by 
QSWAT+, copied into this folder and used as a basis for the results shapefile (and for 
animation).  The aquifer shapefiles were created for the same purpose. Copying them to or 
creating them in the Results directory is done because these shapefiles may be changed by 
subsequent runs of QSWAT+ and not have the same HRUs, LSUs, channels or subbasins as 
this run had. 

If you have saved at least one scenario you will see a box Compare scenarios in the 
Visualise results form (Figure 37).  This allows the visualisation of comparative results from 
two scenarios, and is discussed later.

Select lsunit_pw_mon as the SWAT+ output table.

The pull-down menu in Choose variables contains all the output variables from your chosen 
table.  You can select these one at a time and use the Add button to add them to the box 
below, or simply click All to get all of them. You can adjust your selection by selecting and 
using Del to delete ones, or using Clear to delete all of them. Data from all the variables you 
place in the box will be placed in the results file. You then need to select one of them to be 
displayed.  It is a good idea in general to select All as this allows you to display different 
variables without having to change the results file.
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Figure 37: Visualise results form

For each variable, for each aquifer, channel, LSU or HRU the output data can have a value 
for each day, month, or year of your simulation, or an average year for the whole simulation 
(according to what outputs you chose to print). To display the results graphically we need to 
produce a single value for each variable for each subbasin, and for this we choose a 
Summary. Summaries available are:

 Totals: the summary is the total of the values for the variable for the aquifer, channel, 
LSU or HRU..
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 Daily means: the summary is the daily mean of the total, the total divided by the 
number of days in the simulation.

 Monthly means: the summary is the monthly mean of the total, the total divided by 
the number of months in the simulation. The number of months may be fractional

 Annual means: the summary is the annual mean of the total, the total divided by the 
number of years in the simulation. The number of years may be fractional.

 Maxima: the summary is the maximum value for the variable for the aquifer, channel,
LSU or HRU..

 Minima: the summary is the minimum value for the variable for the aquifer, channel, 
LSU or HRU.

If the output table is an annual average (its name ends in '_aa') the summary method is 
already chosen as annual mean, and the Choose summary menu is not enabled..

For variables which are effectively means, such as rates of flow, only some of the summaries 
make physical sense, namely the mean for the chosen printout frequency, maximum, and 
minimum. Users should therefore exercise caution in choosing summaries for such variables.

Figure 38: Displaying static results

Figure 38 shows the display after selecting table lsunit_pw_mon, variable bioms, and monthly
means as the summary method, and clicking Create.   You will be asked to confirm if you are
overwriting an existing shapefile  The text in the map canvas shows that we are displaying  
bioms monthly mean values from the Default simulation.

The results layer is given a default colouring using 5 intervals chosen by the Jenks natural 
breaks algorithm to cover the range of summary values for the variable. You can change the 
colouring scheme if you wish (right click on the layer entry in the Layers panel, select 
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Properties and then select the Symbology tab).

To display a different variable from the list, select it with the mouse and click Create.  To 
change the summary, select the new one from the pull-down menu and click Create.

We chose an LSU results table, so it was displayed by colouring LSU shapes.  HRU output 
colours HRU shapes.  Results from channels are displayed using channels..  The thickness of 
the channel shapes is proportional to the channel width.

Static results files are supplied with map tool tips showing the channel, LSU, HRU or aquifer 
number, so you can check the number and result value of any feature. Make sure that the 
Show Map Tips button is pressed (Figure 42), and that the results layer is selected in the 
layers panel, and when the mouse hovers over a feature its channel, LSU, HRU or aquifer 
number is displayed, plus the result value.

7.3.1 Combining results 

You might want to display an expression that is a combination of result values, or some 
function of an existing result.  This can be achieved as follows.

First, generate a results shapefile as described above, making sure that you include in its 
variables at least all that you want to use in your expression.  Then right click on its entry in 
the Layers panel and select Open Attribute Table.  Click on the yellow pencil symbol at top
left to start editing, and then select Open field calculator (abacus symbol).

In the Field Calculator make sure Create a new field is checked, give it a name (at most 10 
characters and not already a field name), choose Decimal number (real) as the field type, 
change the length and precision if you wish, and then create the expression.  The easiest way 
to do this is to double click on entries in the centre panel: Fields and Values contains all the 
existing field names, Math contains mathematical functions, Operators a variety of 
numerical and logical operators (some of which are also available as buttons above the left 
panel), and so on.

As you double click on items they are added to the left panel.  You can also edit this panel 
directly (so you can easily delete mistakes).  When the expression is valid the resulting value 
from the first row of the table is exhibited below.

When you are happy with your expression, click OK  to close the calculator and the yellow 
pencil to finish editing. Confirm that you want to save the changes to the layer.

You will find the new field name(s) added to the variables that can be selected for display.  
Select one, change the summary method if you wish, and click Create to see your new 
variable displayed.

Note that this method adds data to the attribute table of the current results file: it does not add
to the current table from the output database.  This means it cannot, for example, be animated
or plotted.  To add such data to the original table it is often possible to use an SQL statement: 
SQL has a powerful expression language.  For example, we could use SQLiteStudio to add a 
column flo_diff, the difference between flo_out and flo_in to channel_sd_mon.  We proceed 
as follows:
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 Open channel_sd_mon and select the Structure tab.
 Use the Add column button to add a column called flo_diff, type REAL
 Click the green tick to confirm the addition
 In the Tools menu select  Open SQL Editor, and type in the command

UPDATE channel_sd_mon SET flo_diff = flo_out - flo_in;
Click the blue Query execute button.

 In the visualise form select a different output table and then select channel_sd_mon 
again to force the table to be reread and the variable made available in the static, 
animation, and plot pull-down menus.

 
Another method to exploit the power of spreadsheets would be to export the table as a csv file
(easily done in SQLiteStudio), import the csv file into a spreadsheet tool like Excel or Open 
Office, add the column(s) and generate their data using the functions available in the 
spreadsheet tool, edit the table structure in SQLiteStudio to add the necessary column(s), and 
import the csv file back into the table

7.3.2 Combining tables

The previous section 7.3.1 presents a method to produce results values based on functions of 
original values, but requires the original values to be in the same table.  But SWAT outputs 
are grouped in a range of tables: what if a function of values from different tables are 
required?  We explain in this section how this can be done.

The tables that can be visualised generally have names in the form X_Y_Z4 where X is lsunit, 
hru, or channel, and Z indicates the frequency: day for daily, mon for monthly, yr for yearly, 
and aa for average annual.  If two tables in the same output database have common X and Z 
values then they can easily be combined in a natural join.  They will automatically share the 
same id, jday, mon, day, yr, unit, gis_id, and name columns, so these will appear in the join, 
and the remaining columns will simply be the union of all the other columns in the two 
tables.
For example, if you use SQLiteStudio, then you can open the output database, in the Tools 
menu select  Open SQL Editor, and type in a command like

CREATE TABLE lsunit_lswb_mon AS SELECT * FROM lsunit_ls_mon NATURAL JOIN 
lsunit_wb_mon;

and click the Execute query button.

Note the new table name lsunit_lswb_mon preserves the X and Z values from the two input 
tables, so that the visualise tool knows how to present the data from the new table.  Now 
reselect the scenario (even if there is only Default),  the new table will appear in the output 
tables menu, and you can proceed as in section 7.3.1 above.

This only illustrates a simple case, and you are free to create new tables from old by whatever
means you like.  You might, for example, want to join tables from different scenarios, if the 
LSUs, HRUs and channels are the same, and the periods of the runs are the same (or you can 
prune them to produce the same common period).  

4  aquifer_ is currently the only exception to the X_Y_ pattern.
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The table below shows how the data from tables is collected for different frequencies, so that 
you can see what is needed in any table you generate:

Frequency Key Order by
Daily gis_id yr, jday

Monthly gis_id yr, mon
Yearly gis_id yr

Average annual gis_id yr5

The table shows, for example, that to extract data for variable x  from a monthly table 
X_Y_mon  for feature f  the SQL statement used by visualise will have the form

SELECT x from X_Y_mon WHERE gis_id=f ORDER BY yr, mon;

And hence that the columns needed in a new monthly table are at least x, gis_id, yr, and mon. 
In addition, of course, the new table's name must follow the X_Y_Z6 pattern described above.

7.3.3 Comparing scenarios

If you have two or more scenarios there is a short cut method for comparing their outputs. 
You will see the Compare scenarios box is visible.  Click the Compare button to open a 
small form that allows you to choose scenarios 1 and 2.  You should choose 1 as the older 
scenario.  For example, if you created a first scenario, saved it as Sim1 and have now created 
a new one, currently the default and not yet saved separately, you should choose Sim1 as 
Scenario 1 and Default as Scenario 2.  Click OK and the text above the Compare button 
changes to Compare Sim1 and Default.  Now make sure you have selected an output table, 
selected a variable, and chosen a summary method, just as you do in a static visualisation.  
Then when you click Create, four files will be added to the Results section of the legend and
displayed in the main canvas:

• a results file for scenario1
• a results file for scenario 2
• a comparison results file, where the values are for scenario 2 minus scenario 1
• a comparison results file where the values are for scenario 2 minus scenario1 expressed as 

a percentage of the scenario 1 value

You should only do this if there is no change in delineation between scenarios 1 and 2, or the 
results are likely to be nonsense as the subbasin numbers are likely to be different in the two 
scenarios.  And if you are choosing to compare HRUs then there should also be no change in 
HRU creation between the scenarios.

Calling the scenarios S1 and S2, the four results shapefiles are created in a directory placed 
within the Default\TablesOut directory, called S1_S2, and named

• S1-<table>-<variable>-results.shp (eg Sim1-wql-ORGN_OUT-results.shp)

• S2-<table>-<variable>-results.shp (eg Default-wql-ORGN_OUT-results.shp)

• <table>-<variable>-diff.shp (eg wql-ORGN_OUT-diff.shp)

5  not strictly necessary but it simplifies the code
6  or aquifer_Z
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• <table>-<variable>-%change.shp (eg wql-ORGN_OUT-%change.shp)

and for all of them the values displayed will be in a field with the name of the variable (eg 
ORGN_OUT).

To turn off  the generation of scenario comparison results files, click Compare again and 
then Cancel in the Compare Scenarios form.  The text above the Compare button reverts to 
Compare X and Y, indicating that the automatic comparison mode is off.

7.4 Printing results

QSWAT+ uses the QGIS Print Composer to support the printing of results.  Figure 39 shows 
the result of adding two more static results files to the display (sedorgn from table 
lsunit_ls_aa and maxima peakr from channel_sdmorph_mon), selecting Portrait as the 
orientation and 3 as the number of maps, and clicking Print.  The print composer is started 
and shows the first 3 (in this case) maps in the Results group in the layers panel, regardless 
of their current visibility.  (It is normal to have only one such map visible at a time in the map
canvas as they are slightly transparent to allow the subbasin, LSUs and channels to remain 
visible.)  Visible layers in the Watershed group are included as background.

The items in the print composer can be edited.  You may want to change the title from its 
default of SWAT+ results: <project>, to edit the Company/Author box appropriately, 
change the map scales, adjust their positions, add other items, etc.  You can then export it as 
an image, pdf or svg file.    To scale several maps, select the Item Properties tab, click on 
one map item, which forms a box round it.  Drag a corner of the box to change the scale.  
Note the scale number.  Then change the others to the same scale, this time by editing the 
number and pressing Enter for the change to take effect. The scale bar is attached to the top 
left map, so it changes with it.  You may also need to use the Position and size settings 
further down under Item properties to keep the maps aligned.

When you have finished with a layout, maybe by exporting it as a pdf, closed it and don't 
want to revisit it, it is a good idea to delete it from the QGIS Layout Manager, since QGIS 
seems to be sensitive to having more than a very few layouts.  Open the Layout Manager 
(using Project -> Layout Manager), select the layout in the manager panel, and click 
Remove.  Or, if you have closed but not removed a layout, you can open it again using the 
Layout Manager's Show button. 
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Figure 39: Printing results

7.5 Animation

To animate, after choosing the scenario and the SWAT output table (e.g. 
channel_sdmorph_mon), select the Animation tab.  The Variable pull-down menu contains 
all the variables from the chosen output table (Figure 40): select one of these (e.g. flo_out). A 
new animation layer is created in the map canvas, showing the initial values of this variable 
in the simulation (Figure 32). Note that the range of possible values runs from 0 to 1.88 (the 
minimum and maximum values for flo_out  for the whole simulation period). You can view 
the actual initial values for each channel by examining the attribute table (right click on the 
Default flo_out entry in the Layers panel and Open Attribute Table).

There are controls to run, pause and rewind the simulation: it steps through daily, monthly or 
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annual time steps according to the chosen table. The speed of the animation can be adjusted 
using the Speed spinbox. You can also investigate the changing values manually, by dragging
the slider, or (with the Visualise Results  form the currently selected window) by pressing the
left and right arrows on your keyboard. The date (day, month, or year) of each step appears 
above the slider.

The animation is achieved by creating a shapefile, in this case rivs0.shp in the Animation  
directory within the Results directory of the scenario. At each time step the values of the 
variable are updated and the file redisplayed. Hence this file is being continuously changed. It
is regarded as a temporary file and so is not preserved.  If you wish to save a view of the 
animation at a particular moment you can pause the animation and make a copy of this file 
(remembering to copy the .dbf, .prj, and .shx files as well as the .shp file).

It is also possible to make an animated gif of the animation.  Click the green Start recording 
button before running the animation, and then the red Stop recording at any point.  You will 
be informed (after a pause while the file is created) that an animated gif has been created 
(called <variable>Video.gif in the Results directory).  Click OK to accept the message, and 
then click Play to see it run in whatever is the default player for animated gifs on your 
machine.  Animated gifs can also be played in web browsers.  The speed of the animated gif 
is determined by the value in the speed spinbox when the Stop recording button is pressed, 
so you may run it at one speed, wait for it to finish or press pause, and then change the speed 
before you click Stop recording.

The animated gif is made by saving a .png file at each time step in the Results/Animation/Png
directory of the Default scenario.  These files are deleted when Stop recording is clicked, so 
if you want to use them, perhaps to make your own animation, you need to copy them before 
you stop recording.

Note that on MacOS it is not possible to record the title on the canvas, which shows the 
changing date as well as the animation variable name.  Users might prefer to use the print 
composer: see below.

We chose to start with the defaults of a New animation in the Map canvas.  If you keep these
defaults and select a new animation, e.g. table lsunit_wb_mon and variable surq_gen then a 
second animation will be added to the map canvas.  Choosing Current would instead cause 
the second animation to replace the first.

Another possibility if you want to watch several animations in parallel is to use the print 
composer as the Animation mode.  Even for a single animation the print composer offers 
more options fo setting the title, author, scale bar etc.  This may be recorded if desired.  Select
Print composer, choose Portrait or Landscape, and change the number of maps if desired, 
and click Start recording.  An information form is shown, explaining that the print composer
will open with the initial layout, which you may edit if you wish (to change the title, author, 
etc.).  Then, if you have changed anything, you should Save as Template, using 
AnimationTemplate.qpt, in the Results directory as the template file, else you can simply 
close the composer.  After doing this, and saving or closing the composer, start the animation.
It runs slowly as it creates a layout and saves it as a .png file at each time step.

58



Figure 40: Choosing an animation variable
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Figure 41: Start animation

As with static visualisation, it is possible to change the colouring scheme used (the colour 
ramp and/or the number of classes): right click on the legend entry, select Properties and 
then select Style.

7.6 Plotting

Plotting allows the rapid display of output data as line graphs or bar charts, plotting values 
against time. It is intended to facilitate comparisons of outputs from different scenarios, or 
different aquifers, channels, LSUs or HRUs, or between simulated and observed values.

Plotting is done in two stages, data collection and display. After collection, just before 
display, data is saved in a comma-separated value (.csv) file. This file can be loaded into tools
like Excel to support more extensive analysis than provided by the plotting tool SWATGraph 
that is supplied with QSWAT+.

7.6.1 Collecting plot data

As with other visualisation options, start by selecting a scenario and SWAT+ output table. 
Then reduce the period if you wish. Next you can select an observed data file if you have one,
and we have observedFlow.csv in the Robit/Observed directory (Figure 33). The structure of 
observed data files is described later.  Observed data is regarded as having the same units as 
the immediately preceding plot: it is not allowed to place it first in the plot table.
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As many plots as you like may be added to the table (but only the first two will be used if you
make a scatter plot). You can start by making sure an output table is selected, e.g. 
channel_sd_mon, and clicking Add plot. This adds a row to the table, and already shows the 
chosen scenario and table. The Unit field is empty and so is the Variable. This first row is 
also the currently selected row, and this is important. Whenever we change the scenario, 
output table, unit or variable settings through their pull-down menus we will immediately 
change values in the currently selected row.  When you have more than one row you can 
select a row by clicking in it.

Suppose we want to compare the main monthly outlet flows from two scenarios.  Then we 
could choose for each scenario the table channel_sd_mon.  We need to find the channel 
number of the outlet channel.  There are several ways of doing this.

1 When we use the Unit pull down menu, as each potential choice is highlighted when 
we move the mouse over it, the corresponding channel, LSU, or HRU is highlighted 
in the map canvas.  This is a good way to check we have the right item if we think we 
know the unit number, but a rather slow method to find a unit by location, like the 
watershed outlet channel.

2 We make sure that the Show Map Tips  QGIS button (Figure 42) is pressed, select 
the appropriate map in the layer panel (rivs1, gridstreams or drainstreams for 
channels; Inlets/outlets for points marked in the inlets/outlets file; Pt sources and 
reservoirs for point sources and reservoirs added by QSWAT+; lsus2 or lsus for LSUs;
hrus2 or hrus for HRUs; aquifers for aquifers) and hover the mouse over the feature.  
A map tool tip will be displayed showing the unit type (e,g, Channel) and number.

3 We select the appropriate map in the layers panel, as in the previous method 2.  We 
click  the Identify Features QGIS button (Figure 42), and click on the intended 
feature, such as the outlet channel (Figure 43). We see from the Identify Results 
panel that the channel number is 17, so we select 1 as the Unit. 

Figure 42: Identify Features and Show Map Tips buttons

We select flo_out as the Variable. Now we want to add a second row to the table for the other
scenario. A convenient way to do this is the Copy plot button. This copies the current row to 
a new row, and makes it current. Then all we have to do is choose a new scenario and the 
second row will be what we want. 

7  This number may be different on different machines, or with a change in the number of MPI processes.
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Figure 43: Identifying the outlet channel

It is also possible to move the current row up or down: this just affects the ordering of the 
plots in the output.

To add observed data we select an observed data file, and use the button Add observed. 
observed is used as the scenario name, '-' is used for Table, and Unit, and we can select a 
variable name from the file.

We use the observed data file observedFlow.csv from Robit/Observed.  There is only one 
variable, in this file, Flow, so it is already selected in the observed row.
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Figure 44: Plot screen

Set the Plot type to Graph/bar chart.  (We describe other plot types later.) Then click Plot. This
invites us first to choose a .csv file to save the data. We can if we wish later import this into, for 
example, Excel if we wish to do further manipulations or use Excel’s graphing tools.    Provide a 
name, eg  flow, and click Save.

If we do this for this example, we immediately get a message that there is missing data for 
1998/1 (i.e. January, as we are using monthly data) for plot 2, which is the observed plot.  The 
observed data only runs from the beginning of 1993 to the end of 1997.  We click OK to close 
the message, change the finish year to 1997, and click Plot again. We can choose the same .csv 
file, and the tool checks that we are happy to overwrite the file.  We click Yes.
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Once the data is written to the .csv file, SWATGraph is automatically started to display the data 
graphically: see Figure 45. The data has been displayed as line graphs. We can change the display
to bar chart using the Chart Type pull-down box and clicking Update Graph. Figure 45 shows a
plot of the flow out of channel 1 against the observed data file observedFlow.csv supplied with 
the Robit example.  .

Other SWATGraph options include importing another (similarly created) .csv file, using New 
File to Plot, and using the buttons immediately below the graph.  These include zooming and
panning the graph, saving the graph in a variety of image formats (the rightmost button) and a
number of editing options (rightmost button but one).  You can add a title, change axis labels, 
change the colours of the plots, and (for line graphs only) change the vertical axis from linear 
to log scale, which is useful when there is a wide variation in values.  

The data from the .csv file is also displayed. The column headings, also shown in the graph 
legend, take the form Scenario-Table-Unit-Variable(Units), where Unit is the aquifer, 
channel, LSU or HRU number as appropriate for the table, and Units is the units in which the
Variable is measured.. For an observed plot the form is observed-Variable.

At the bottom of the screen some statistics are displayed. These are correlation coefficients 
and Nash coefficients for each pair of plots. Some of these may be meaningless, of course, if 
for example you choose to plot four things that are really two pairs, but it is quicker as well as
simpler to calculate them all than it is to ask the users what they want.

SWATGraph may also be run as a stand-alone tool.  Double click on runSWATGraph.bat 
(Windows) or runSWATGraph.sh (Linux and Mac) to start it, or use this as the command in a 
command shell.  In a command shell you can optionally add the path to a .csv file to plot the 
csv file automatically at the start.  runSWATGraph is in SWATPlus/Tools/SWATGraph if you 
installed it with QSWAT+, else, in Windows if you had it from QSWAT, in 
C:/SWAT/SWATEditor.  In Windows you need to check that the setting of  OSGEO4W_ROOT
in the second line of runSWATGraph.bat matches the path to your installation of QGIS.  If 
your QGIS is not a long-term version you will also need to change the QGISNAME setting in 
the next line to qgis instead of qgis-ltr.
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Figure 45: SWAT Graph

7.6.2 Plot types

A number of plot types are supported:

• Line graphs/bar charts
• Flow/load duration curves
• Scatter plots 
• Box plots

The type can be selected from the Visualise Results form, as we saw earlier, before starting 
SWATGraph, or from the Plot type pull-down menu in the SWATGraph form.

The first of these was covered above.
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Figure 46 shows the result of adding the variable sed_out for channel 1 from the 
channel_sdmorph_mon table and using plot type Flow/load duration curve.  This illustrates 
another feature of the line graph and duration curve plots that when the variables are different 
extra axes are added on the right, showing the appropriate range of values for each additional 
variable.  The colour of the axes matches the colour of the (first) graph for that variable.  There is
no need for an axis for the observed data because it is assumed to match the variable of its 
immediately preceding graph, that for flo_out.

Changing the SWATGraph plot type to Box plot gives the result shown in Figure 47.  There
is a box plot for each data set, and those sharing the same variable are grouped together.
Numerical values for each box plot (minimum, maximum, median, lower and upper quartiles)
are included in the bottom panel.

To illustrate scatter plots we  Close SWATGraph, delete the observed data line in the plot
table, so we are left with the flo_out  and sed_out lines, and select Scatter plot as the type.
Plotting this is shown in Figure 48.  The line of best fit is drawn as well as the scatter points.
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7.6.3 How compatible do different scenarios need to be?

The period is automatically adjusted to include all the scenarios involved (but see below for 
observed data).

You also need to be reasonably confident that the things you want to compare are indeed 
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Figure 48: Scatter plot



comparable, so if you are comparing HRUs, for example, they should be the same HRU in 
each scenario. But if you are comparing the main outlet channel in each scenario, which gives
figures for the whole watershed, it doesn’t matter how the subbasins, LSUs and HRUs in 
each were selected, or how the units are numbered, as long as you select the main outlet 
channel number for each.

7.6.4 Including observed data

To include observed data you need to prepare a .csv file, i.e. a text file where each line 
consists of the same number of items (one or more), separated by commas. 

The first line must be comma-separated text strings, which will be used as the variables. If the
first string is DATE, or Date, or indeed these four letters in any case, it and the data in the 
first column are ignored. The dates are assumed to be the same as in the SWAT output plots; 
they are not checked.

The data on lines two to the end (apart from ignored dates) should normally be numeric.  If 
you do not have complete observed data, you should include the relevant dates in the file, 
since dates are assumed to be sequential, but leave the data fields empty.  You still need to 
insert the same number of commas as in other lines.  In fact you can put anything in the 
fields, like "missing" if you wish: any field that SWATGraph cannot parse as a number will 
be taken to be missing data.

Dates on which some data is missing are excluded from the Pearson and Nash coefficient 
calculations (and the number of values used in the calculation is reported).  Missing data will 
appear as breaks in the relevant line graph, and as missing bars (indistinguishable from zero 
values, of course) in bar charts.  You can check where data is missing from the data table, 
where you will see blank fields, or the text like "missing" that was used in the .csv file.

Table and Unit boxes in an observed plot row will be unavailable, but you need to choose a 
Variable. The choices in the Variable pull-down box will be the variables (apart from date) in 
the first line of the .csv file.

8 Post processing

Post processing of SWAT+ results is available via the Visualise form, under the tab Post 
processing.

8.1 Environmental flows

Three environmental flow statistics are available, Qq, dQp and Qb.
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8.1.1 Qq

The Qq statistic provides, for each calendar month, a measure of the flows for that month 
(including for each calendar month the flows that occur in that calendar month regardless of 
the year) that satisfies the condition that q% of the flows exceed the measure.  The user 
chooses the subbasin and the value of  q.  The flow is the flow in m³/s at the outlet of the 
subbasin, so if the subbasin immediately above the watershed outlet is chosen then the 
statistics are for the whole watershed.

Calculation of Qq depends on data in the channel_sdmorph_day table in the outputs database,
so channel in the Daily column must have been be selected amongst the outputs to be printed 
by the SWAT+ Editor.

The Qq form initially selects 95 as the percentage q and the outlet subbasin for the watershed 
(7 for the Robit example), as illustrated in Figure 49.  (If there is more than one watershed 
outlet in the model, the one chosen is arbitrary.)  The user can change the percentage and 
subbasin, and also change the period if desired, before clicking Calculate.  The result for 
each month is then written to the table.  The results can be saved to a text file using the Save 
button.  If the Append box is checked the results will be appended to the selected file, 
allowing for results for different parameter settings to be saved together.

8.1.2 dQp

The dQp statistic provides a single flow statistic for a given subbasin, where d is the number 
of days for a moving average, p is a threshold percentage.  The initial form is shown in Figure
50.  21 is the default for d, 5 for p, and the watershed outlet subbasin for the subbasin.  Users 
also need to choose a start month and can choose between Percentile and Mean as the final 
statistic selection. The statistic is a flow in m³/s.

Calculation of dQp depends on data in the channel_sdmorph_day table in the outputs 
database, so channel in the Daily column must have been be selected amongst the outputs to 
be printed by the SWAT+ Editor.

The calculation of dQp is as follows:
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Figure 49: Initial Qq form
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Figure 50: Initial dQp form

 The chosen period is divided into successive year-long periods, starting with the first 
day of the start month and finishing with the last day of the preceding month one year 
later.  Days before the first start month are ignored, as are days at the end that do not 
make a complete year.  For example, if the chosen period is from the start of 1993  to 
the end of 2000 (so is 8 years long) and the selected start month is April, then the 
division will give 7 year-long periods, the first running from 1 April 1993 to 31 March
1991, and the last running from 1 April 1999 to 31 March 2000.  Common start month
choices are January (natural), October (hydrogeological) and April (hydrobiological). 
The month should be chosen so that it is not in a low flow period.
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 Moving averages of length d days are calculated for the daily flows for each year 
period, and for each year period the minimum moving average is selected as the flow 
for that year.

 There are then two possible methods for selecting the final statistic from the flows for 
the year periods:

o Percentile:  The result is the flow value which is not exceeded by p% of the 
flows for the year periods.  For the default settings, the result would be called 
21Q5.

o Mean:  The result is the mean of the flows for the year periods.  For the 
default settings the result would be called 21Qm.  Note that the value of p is 
ignored.

The choice between these methods is made by selecting the appropriate radio button 
in the Final selection group box.

The most common dQp index is undoubtedly 7Q10, widely used since the early 1970s by 
U.S. agencies dealing with river pollution. Water quality is considered acceptable if the flow 
is equal to or greater than 7Q10. Other countries, such as Spain, suggest the use of 25Q10 as 
representative of the environmental flow in a year

Note that some authors may use a dQq statistic in which q is interpreted as in the Qq statistic 
described earlier, such that the results ARE exceeded q% of the time, instead of the results 
NOT being exceeded p% of the time.  With that interpretation, choosing q as 95, say, would 
be the same as choosing p as 5 (100-q).  Typically p is small and q large, so a statistic such as 
21Q10, for example, is unlikely to be misinterpreted. 

After setting the parameters, the result is calculated and displayed in the form by clicking 
Calculate.  The result can be saved to a text file using the Save button.  If the Append box is
checked the result will be appended to the selected file, allowing for results for different 
parameter settings to be saved together.

8.1.3 Qb

The Qb (Basic Flow) statistic provides for a given subbasin an annual statistic and also 
monthly statistics. The initial form is shown in. Figure 51.  The watershed outlet subbasin is 
the default subbasin. Users also need to choose a start month.  The annual and monthly 
statistics are flows in m³/s.
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Figure 51: Initial Qb form

Calculation of Qb depends on data in the channel_sdmorph_day table in the outputs database,
so channel in the Daily column must have been be selected amongst the outputs to be printed 
by the SWAT+ Editor.

The calculation of Qb is as follows:
 The chosen period is divided into year-long periods according to the start month in the

same way as for dQb: see subsection 8.1.2 for details.
 For each year period, moving averages of outflows over periods of length 1 to 100 

days are calculated, followed by selecting the minimum moving average for each 
period length.  Then the rate of change of the minimum moving average is calculated, 
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comparing the minimum moving average for period length i to that for period length 
i-1, 1<i≤100.  If period length j gives the highest rate of change then the 
corresponding minimum moving average for period length j is selected as the flow for
that year period.

 The annual result is the mean of the results for the year periods.
For each month, the monthly statistic is calculated by multiplying the annual result by
the variation factor for the month.  To calculate the variation factors we calculate the 
mean daily flow for days falling in each calendar month, and note the minimum of 
these means.  The variation factor for a month is then the square root of the ratio of 
mean for that month to the minimum mean. 

After setting the parameters, the result is calculated and displayed in the form by clicking 
Calculate.  The result can be saved to a text file using the Save button.  If the Append box is
checked the result will be appended to the selected file, allowing for results for different 
parameter settings to be saved together.

9 Using grid models

As well as using watershed divided into subbasins and (optionally) landscape units, QSWAT+
supports division of the watershed into square grid cells.  The grid cells are treated by 
SWAT+ as small subbasins, and they may be divided into landscape units and HRUs in the 
same way.  Grids allow in particular for finer control over drainage patterns.

9.1 Creating a grid

You can create your own grid using watershed delineation as described earlier for the Robit 
watershed, but before clicking the Create watershed button you need to check the box Make
grid and set the Grid size that you want in the spin box.  Grid sizes are defined in terms of 
DEM pixels.  So, for example, for the Robit example we have a DEM whose pixels are 30 x 
30 metres: you can see the pixel size after loading the DEM by selecting the DEM 
properties tab in the delineation form.  We will choose a grid size of 3, so that our grid cells 
are 90 x 90 metres (Figure 52).

A couple of things have changed in the form as a result of choosing to create a grid.  First, 
there is no channel threshold to set.  Grids cells are in many ways treated like subbasins, but 
will  be small, so there is no reason to allow multiple channels within them.  Effectively 
channels are the same as streams.  Second, the option to merge subbasins is not available.  
(The tab is still there, but its contents are not enabled.)  Grid models are designed to be 
homogeneous in grid cell size, so it makes no sense to merge them.  Otherwise, things are 
much the same as the non-grid case: inlets and outlets can be defined, lakes can be added, and
floodplain maps can be created and used to form upslope and floodplain areas.  If we do this, 
we will find it sometimes the case that grid cells are entirely floodplain or entirely upslope.

The result of clicking Create watershed is shown in Figure 53.  The watershed delineation 
has been done as before, and then grid cells created to cover the watershed.  There are 2,185 
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grid cells in the result: you can see this by right clicking on the Watershed grid entry in the 
layers panel and selection Show Feature Count.  A new streams layer Grid streams has also
been created, containing stream reaches to connect grid cells.  These reaches are created by 
connecting the points of maximum flow accumulation in each grid cell, and you should find 
if you make visible the original stream network calculated by TauDEM (the layer named 
Streams) that they show good consistency (for small grid sizes)  The grid streams shapefile 
has an attribute Drainage whose values are the areas in km2 draining to the outlet of each grid
cell, and this is used to set the widths of the stream lines in the map canvas.

After clicking the final OK button on the delineation form, creating HRUs proceeds exactly 
as in the non-grid case.  Processing times will typically be longer, because we are dealing 
with much larger numbers of landscape units or subbasins, and of HRUs.  Figure 54 shows 
the Create HRUs form after we have selected the landuse and soil maps, imported the csv 
files for landuse and soil lookup and for the usersoil table, and clicked Read.  There are 2185 
subbasins (since each grid cell is a subbasin). 2185 channels (or streams - remember they are 
the same) and 2502 potential HRUs.  When we click Create HRUs at this point we will get 
one HRU per grid cell, since the Dominant HRU choice is currently selected.  We can have 
more HRUs by selecting a different filter, but it is clear that most grid cells already have only 
one HRU in any case.
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Figure 52: Making a grid
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Figure 53: Grid created
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Figure 54: About to create HRUs

9.2 Using an existing grid

You can use a grid created as in the previous section, or one obtained from another source, as 
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an existing grid.  We start, as before, with running the watershed delineation form and 
loading the DEM: we will need this because we need to calculate slopes.  Then we choose the
Use existing watershed tab, and click Use grid model.   Next we load a grid shapefile.  We 
can use the grid we created in the Demo1Grid project in section 9.1.  We will find it under the
project folder as Watershed/Shapes/grid.shp.  The delineation form is shown in Figure 55.    
The inlets/outlets shapefile is optional, and certainly unnecessary if it only contains outlet(s), 
as in our example.  The important thing to notice is the Drainage definition box, which 
contains three options.  These options concern how the grid cells will drain into each other.  
The first option, Grid shapefile, is based on using data stored in the grid shapefile.  Grids 
created by QSWAT+ have attributes PolygonId  and DownId. PolygonId (the standard 
identifier for subbasins used by TauDEM) is unique to each grid cell.  The DownId value is 
another PolygonId, indicating which other grid cell this one drains to, or -1, indicating a 
watershed outlet.  The second option is to use Streams shapefile, and its LINKNO and 
DSLINKNO attributes will be used to define the drainage routing.  As in the non-grid case, 
each stream reach also has a WSNO attribute, which is the same as the PolygonId attribute in 
the watershed shapefile.  (For streams created by QSWAT+ the LINKNO and WSNO values 
will often be the same, but this is not required.)  The watershed grid shapefile also has an 
attribute Subbasin, and it is these Subbasin values which are displayed in the map canvas 
(seen for grids only when you zoom in sufficiently) and will be used as subbasin numbers by 
SWAT+.  To use the streams shapefile option we select it and then  we can load the file 
gridstreams.shp  created also in the Demo1Grid  project in section 9.1., and found in its 
Watershed/Shapes folder.  In Figure 56 we can see that subbasin 1 drains to 6, which drains to
15 and so on.  These drainage routings are defined by the LINKNO and DSLINKNO 
attributes in the stream shapefile, but also by the PolygonId and DownId attributes in the 
watershed grid shapefile.  In fact the streams shapefile is strictly unnecessary.
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Figure 55: Using an existing grid
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Figure 56: Subbasin number and drainage pattern

If we select for Drainage definition the option Grid shapefile then the option to add a 
streams shapefile disappears, and when we click the Run button a streams shapefile is 
created with links the centre points of the grid cells (Figure 57).  This is created using only 
the watershed grid's PolygonId and DownId fields.  We do not use any accumulation values, 
so the best we can do is link the centres of grid cells.  You may think this gives a coarser 
model of the physical terrain (though to SWAT+ it will be just the same as the previous 
version) but the great advantage is that it can be changed by the user without any danger of 
terrain analysis contradicting what the user wants.  So if you know that, for example, in part 
of the watershed the drainage has been artificially changed for irrigation, you can change the 
DownId values in the watershed grid shapefile.  Just make sure that all rows have a valid 
DownId and there are no circularities!  Then choose Watershed shapefile as the Drainage 
definition option.
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Figure 57: Drainage pattern using watershed grid to define drainage

The third Drainage definition option is Drainage table.  This is functionally the same as 
using the watershed shapefile, but allows users to create a csv file containing the Subbasin 
and downstream subbasin values.  When we select Drainage table we have a drainage table 
button allowing us to find and load a csv file.  If we previously prepared our watershed grid 
shapefile using QSWAT+ then we will find in the Watershed/Shapes directory a file 
<project>drainage.csv, in our case DemoGriddrainage.csv, created when the watershed grid 
was created, with Subbasin and downstream subbasin values corresponding to 
PolygonId/DownId values.  This can be edited and used as the drainage table.  If you create 
such a file from scratch, the first line is ignored, and there should then be two integers on 
each line separated by a comma.  The values in the first column should be non-negative and 
unique, and values in the second column should appear in the first or be -1 (indicating an 
outlet).  Note that these values are subbasin numbers, as seen in the grid labels, to help users 
change the values while using the map as reference.  Subbasin numbers may be the same as 
PolygonId values, but this is not necessarily the case.

10 Adding lakes

QSWAT+ allows for lakes to be included as shapefiles in watershed delineation.  Here we 
describe the requirements on lake shapefiles, how to include them,  the issues which can 
arise, and how water flows into and out of lakes are routed.

10.1 Polygon shapefiles
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Polygon shapefiles may define lakes in 4 categories:

 Reservoirs
 Ponds
 Wetlands
 Playas

Reservoirs, ponds and wetlands must be associated with channels: they normally have at least
one outlet channel, and they may have several inlet channels (or none).  So most of the 
calculations involved in delineating such lakes are involved in determining what channels 
form the inflowing and outflowing channels for each lake.

A lake is defined as a reservoir if it has an attribute RES with value 1, as a pond if it has an 
attribute RES with value 2, and as a  wetland if it has a RES value 3.  Playas are lakes with 
RES value 4.  Lake shapefiles without a RES attribute are considered to define only 
reservoirs, i.e. 1 is the default RES value.

Playas do not form separate items in delineation: they simply override the landuse their pixels
are assigned from the landuse map, and so directly create HRUs, with landuse WETW.  
Reservoirs, ponds and wetlands do form separate items in delineation, so that the subbasins, 
landscape units and HRUs of the model only occupy the pixels in the model that are not part 
of reservoirs, ponds and wetlands.  Reservoirs, ponds and wetlands may be quite large: they 
may occupy regions that might be delineated as more than one subbasin were they not 
present.

The rest of this section is concerned only with reservoirs, ponds and wetlands, and the term 
'lake' is used to encompass all three, but not to include playas.

Lakes are defined in polygon shapefiles, and we first need to understand a little about how 
such shapefiles are structured.  A shapefile contains a number of shapes, and each shape 
consists of 1 or more parts.  This introduces an ambiguity into how shapefiles are 
constructed.  A lake containing an island, for example, could consist of two shapes each with 
one part, or a single shape with two parts.

For QSWAT+ we need to represent each lake as a single shape (though it can be in a shapefile
with several lakes).  In addition, we will simplify it further by reducing it to a single part, its 
outer perimeter.  We will be checking how channels cross the perimeter, and having them 
accidentally cross islands just makes things unnecessarily complicated.  In the example from 
the previous paragraph, a lake and an island as two shapes should first be reduced to a single 
shape.  This is the responsibility of the user, and we will demonstrate how it can be achieved, 
by dissolving shapes.  The isolation of the perimeter as a single part is done automatically by 
QSWAT+.

10.2 Dissolving shapes

83



Figure 58: Lake composed of multiple shapes

Figure 58 shows a lake composed of 15 shapes.  You can see how a lake is composed by 
loading the shapefile into QGIS, right clicking on its entry in the Layers Panel, and selecting 
Open Attribute Table.  More than one entry in this table for what is considered a single lake 
indicates it is composed of several shapes.  Selecting a line in the table will highlight the 
shape, as in Figure 58.

To dissolve the shapes, use Vector -> Geoprocessing Tools -> Dissolve.  If the lake is the 
only set of shapes in your shapefile you can ignore the Selected features only option and the 
Dissolve fields.  Otherwise you will need either to select the features in your lake in the map 
canvas and click Selected features only, or find (or add) a field, or collection of fields, that 
distinguish the shapes forming the lake.  Select a location and name for the new shapefile and
click Run.   Opening the new shapefile and its attribute table will demonstrate that you now 
have a single shape for each lake.
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Figure 59: Dissolved shape (detail)

Although we have a single shape, in fact it still may have several parts, because dissolve only
joins together parts that physically touch or overlap.  Figure 59 shows the north-east corner of
the dissolved lake, where we see that it was not very well digitized here: several parts are still
separated.  When QSWAT+ later selects the perimeter it will select the part with the largest 
area.  But it will also warn if the next largest part (if any) has an area more than 5% of the 
largest part.  To avoid a significant part being lost, go back to the original shapefile, go into 
editing mode, and drag some points on the edge of one part so they are inside the part you 
want to join with.  Save the edit and rerun the dissolve.

If you have your dissolved lakes in more than one shapefile, you can easily create a single file
containing them all.  Load them all as layers in QGIS, then use Vector -> Data Management 
Tools -> Merge Vector Layers.  But first make sure they all have the same projection.   This 
will need to be the same as your DEM's projection.

QSWAT+ needs an integer to identify different lakes.  You can define this yourself by 
including in your lakes shapefile a field LakeId and assigning a different number to each lake.
Or you can leave it to QSWAT+ to add such a field and numbers 1, 2, etc.  This is only done 
to the copy of the lakes shapefile within the project.  When you load the lakes shapefile each 
lake will be labelled  Lake n  where n is its LakeId value.

The lakes shapefile may also have a field RES indicating with value 1 if the lake is a 
reservoir,, or indicating with value 2 that it is a pond, or indicating with value 3 that it is a 
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wetland, or with 4 that it is a playa.  If there is no such field the default is reservoir.

10.3 Delineation with lakes

The lakes shapefile is selected in the delineation form, and can be added after you have run 
delineation. The shapefile is loaded as a layer, and as with all input maps is copied, in this 
case into the Watershed/Shapes directory, keeping its file name.  But it is not a simple copy: 
each shape is reduced to the outer perimeter  of its largest (by area) part.  As mentioned 
above, the user is warned if there are any ignored parts with an area more than 5% of the 
largest part.   The rest of the processing happens when you click the final OK button in the 
Add Lakes tab.  It proceeds as follows:

10.3.1 Channel splitting

It is required that each lake has an outlet.  Examples which have a single outlet and cause no 
problems are illustrated in Figure 60, Figure 61, and Figure 62.  

Figure 60: Single outlet; no inlets
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Figure 61: Single outlet; single inlet

Figure 62: Single outlet; multiple inlets

The aim is to divide channels which interact with each lake into three groups: channels which
enter the lake (which will terminate at the lake boundary), channels which leave the lake 
(which will start at the lake boundary) and channels entirely within the lake.  So the single 
channel in Figure 60 will be split into a channel within the lake and a channel leaving it.  The 

87



single channel in Figure 61 will be split into a channel entering the lake, a channel within it, 
and a channel leaving it.  Figure 62 involves three channels: two entering the lake and one 
leaving it.  These will each be divided where they cross the lake boundary, so we eventually 
have two channels entering, three inside, and one leaving.

Figure 63: Before splitting channels

Figure 63 shows part of the channel network after delineation and before channel splitting, 
with one channel highlighted in red.

Figure 64: After splitting channels
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Figure 64  shows the effect of splitting channels.  We have highlighted the upstream channel 
of the pair that has replaced the previously highlighted channel.  The downstream channel is 
within the lake.

The aim of splitting channels is to find out what areas drain to where.  Areas that drain to the 
new upstream channel outside the lake will be routed to that channel and thence to the lake.  
Areas that drain to the new downstream channel inside the lake will  instead drain directly 
into the lake.  You might expect such areas to be themselves in the lake, but this is not the 
case.   Figure 65 shows the original drainage area of the single channel highlighted in Figure 
63.   Figure 66 shows the drainage areas after splitting channels and then adding the lake.  
The lake area has been deleted from the drainage areas.   The yellow area in Figure 66 is the 
area draining to the new upstream channel.  The blue area is the area that remains of the 
yellow drainage area in Figure 65 that is outside the lake.  This is the area that technically 
drains into the downstream channel, but in the SWAT+ model will drain directly into the lake.
In fact in the SWAT+ model the channels inside the lake are removed.

Figure 65: Channel drainage areas before channel splitting

Note that LSUs are formed from channel drainage areas: one LSU per channel if no 
floodplain is used, else two (floodplain and upslope) if a floodplain is used.  LSU numbers 
are related to channel numbers: if a channel has number n  then the corresponding single LSU
will have number 10 * n.  When a floodplain is used, the two LSUs will have the number 10 
* n + 1 (floodplain) and 10 * n + 2 (upslope).  This makes it easy to relate LSUs to channels.

A consequence of removing channels inside lakes while keeping channel drainage areas like 
the blue area in Figure 66 is that there will be LSU numbers that do not relate to any channel 
numbers: the blue area's LSU number(s) will be related to a channel number that has been 
removed.  If no floodplain is used, the number of LSUs is normally equal to the number of 
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channels.  But if lakes are included the number of LSUs will typically exceed the number of 
channels.

Figure 66: Drainage areas after channel splitting

10.3.2 Problems

Ideally, each channel interacting with a lake should fall neatly into one of the three 
categories:  entering, leaving and within.  But in practice things are not so simple.  Lake 
boundaries may not coincide with the model of channels and basins created by delineation, 
which is always imprecise, and on flat areas like the surfaces of lakes particularly so.  Neither
can we rely entirely on the lake shapefile: separated parts can occur as we have seen, and in 
any case the perimeter of a lake at the end of the dry season may be significantly different 
from its perimeter at the end of the wet season.  We have to accept compromises and use our 
judgement and local knowledge.

The first problem is when the requirement that every lake must have a channel outlet is not 
met.  This might happen because a lake is outside the watershed boundary (Figure 67) or 
because no channel interacts with it (Figure 68).   When there is no outlet QSWAT+ zooms to
the lake with the problem and asks the user if they wish to remove the lake, or if they want to 
keep the lake and try to correct the problem.  If the user clicks Yes to removal the lake is 
removed from the copy of the lakes shapefile in the project.  Otherwise the lake remains and 
the user needs to correct the problem in some way, such as changing the channel threshold, 
burning in a channel map, or editing the lake polygon, and then rerunning delineation. 
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Figure 67: Lake outside the watershed

Figure 68: Lake not on a channel
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Figure 69: Multiple crossings

Figure 69 is an example of a channel (highlighted in red) that starts in the north outside the 
lake (perimeter in black) and crosses the lake boundary three times.  Since the channel starts 
outside the lake and terminates within it, it will be designated an inflowing channel and split 
at the point where it crosses the lake boundary which is nearest to the channel source.  A 
warning is given to the user that this designation has been made.

i
Figure 70: Another multiple crossing example

Figure 70 shows an example where a channel (again highlighted in red) starts and finishes 
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outside a lake.  Unless there are no other channels leaving the lake (as in Figure 61), the 
designation made is that it should not in fact cross the lake boundary; all the water in its 
channel basin will be routed into the channel and thence to the channel outlet in the south-
west.  Again the user is informed of this designation.

Figure 71: A channel internal to the lake with multiple crossings

In a similar fashion, a channel that starts and finishes within a lake but crosses the boundary 
is regarded as internal to the lake, with a warning to the user.   Figure 71 is an example 
involving multiple crossings.  

A channel that starts inside the lake and finishes outside it but crosses the lake boundary more
than once is designated an outflowing channel, again with a warning, and split at the crossing 
point nearest its outlet.

10.3.3 Fixing problems

It may be that the designations selected by QSWAT+ in the cases above are not appropriate.  
There are also problems where an error is reported and the user needs to take action.
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Figure 72: Channel in lake appears to be an outlet.

In Figure 72 the lake is the area in the left and bottom of the figure: there is a spit of land 
coming into the lake from the north-east.  The channel highlighted in red, mostly internal to 
the lake and flowing north-east to south-west, appears to terminate on land, so terminates 
outside the lake.  Similarly the channel flowing roughly east to west appears to terminate 
outside the lake, and the channel flowing to the south-east appears to be an inflow, since it 
starts outside the lake.  All of these are wrong, and a warning about multiple lake outlets will 
be reported.  We need to arrange it so that the channel junction is in the lake rather than on 
land.  We could try to achieve this by editing the channels shapefile to move the ends of the 
channels, but if we ever rerun the delineation the error will recur.  We could try to avoid this 
by burning in the adjusted channels shapefile, but this method is not always reliable.  A better
approach is to shift the lake boundary a little, in this case to move a few points at the end of 
the spit of land so that none of the three channels cross it.

Figure 73: Multiple outlets

Figure 73 illustrates a situation which will also be reported as a lake (on the right) having 
multiple outlets.  In this case there are three things we could do:
1 We can ignore the warning.  The short lower channel (assuming it has a smaller drain 
area than the upper one) will by default receive 0% of the lake's outflow, and the upper chan-
nel (assuming no other outlets) will receive 100%.  Effectively the lower channel is treated as
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internal to the lake.  But the outlet routing of 0% remains, and we could change the percent-
ages later with the SWAT+ editor.
2 The short lower channel might disappear if we increased the channel threshold a little 
and ran delineation again.  However, the channel threshold  applies across the watershed and 
the new threshold might not be suitable elsewhere.
3 We could edit the lake so that it crosses the upper channel just to the west of the junc-
tion of the two outlet channels.

10.3.4 Short outlet channels

Sometimes it is natural to make the outlet from a lake the outlet from the whole watershed.  
How can we achieve this while obeying the rule that each lake has one main outlet channel?   
We don't want to create a short channel with a correspondingly small channel basin.  There is 
an extra condition that if a watershed outlet (an outlet with no other outlets downstream) is 
placed on a channel within a lake and close to the lake boundary, then the channel is extended
to the boundary and the outlet moved to the channel's new outlet.  The definition of "close" in
this context is (approximately) the same as used for snapping points to channels: 300m by 
default.  If a watershed outlet is placed further away from the boundary then the lake is 
considered to be closed: it may have inflows but it has no main outflow.
This solves the problem of placing a watershed outlet on a lake boundary, but there is a 
similar issue that lake outlets can often occur very close to subbasin outlets, with a short 
channel between them.  We cannot easily shift the subbasin outlet, which is determined by 
delineation, so how can we avoid the small channel and (perhaps) correspondingly small 
channel basin?  To deal with this there is another special condition: if  the outflow channel 
from a lake has a drainage area less than 1% of the lake area, then the channel is regarded as 
internal to the lake, and the water flow from the channel basin will be into the lake instead of 
into the channel.  

10.3.5 Multiple outlets

Normally one expects a lake to have a single outlet.  But it is sometimes the case that lakes 
have other outlets, water being drawn for irrigation, for example.   QSWAT+ allows for 
multiple outlets, but the user is always warned if the number of outlets is different from the 
most common case of 1.  As we have seen, extra outlets are commonly the result of a 
mismatch between the results of delineation and the real world.  So there is an assumption 
that less important outlets are probably mistakes.  If there are multiple outlets, QSWAT+ 
compares the drainage areas of each (according to the original channel network, before lakes 
are added).  The one with the largest drainage area is designated the main outlet.  When the 
routing table is constructed, the main outlet will be assigned 100% of the lake's outflow.  The 
other outlets will route 0% of the lake's outflow to their downstream channels, and so by 
default will be ignored.   These percentages can of course be changed in the SWAT+ editor.

10.3.6 Closed lake basins

It can be the case that there is no outlet from a lake: the lake basin is closed.  It is difficult to 
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delineate such a basin because the first step, pit-filling, fills the lake!  We have to enable the 
pit-filling program of TauDEM to leave the lake much as it is, by creating a watershed outlet 
within the lake.  We do this by making a 'hole' in the DEM, an area of nodata pixels.  We need
to make this as small as possible, because there may be some areas that drain to it but are 
insufficient to form a stream.  This does no harm as long as such areas are within the lake.

To cut the hole in the lake, create a polygon shapefile.  Use the New Shapefile Layer button, 
make the geometry type Polygon, and its projection the same as the DEM.  Save it 
somewhere convenient, and after clicking OK it will appear in the layers panel.  Start editing 
it (yellow pencil button)  and click Add Polygon Feature. Add vertices with the left button, 
and when all are added finish with the right button.  Click the yellow pencil again to finish 
editing, and save.  You want a polygon that  occupies a region in roughly the centre of the 
lake (Figure 74)

Figure 74: Core shape created

To cut the hole, make a copy of the DEM (easily done with Copy  and Paste  in Windows 
Explorer, for example) and name it, say, dem1.tif.  Then open the Python Console, and click 
its Show Editor button.  Make a Python script like the one below, save it as, for example, 
rmcore.py.  Here -2147483647 is the nodata value for your DEM (which in this case appeared
as -2.14748e+09): to find it right click on the DEM entry in the legend panel, select 
properties, and find the Bands  data in the Information tab.  X and Y are the full directory 
paths for the core shapefile and DEM copy respectively.  
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import subprocess

args = ['C:/Program Files/QGIS 3.22/bin/gdal_rasterize', 

    '-burn', '-2147483647', 

    'X/core.shp', 

    'Y/dem1.tif']

    

subprocess.call(args)

Python script for cutting core.shp from dem1.tif

Replace the original DEM in the delineation form with dem1.tif, which should look like
Figure 75.   Run Create Streams,  and the result should be like Figure 76.  If the streams are 
entering the removed area, all is fine.  If they area instead flowing through the lake and 
exiting the core area needs to be enlarged and/or moved.  Remake dem1.tif as a copy of the 
original DEM, edit core.shp, cut the hole in dem1.tif  again, reload as the DEM and run 
Create streams again

Figure 75: DEM with core removed
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Figure 76: Streams created

If the streams are flowing into the hole, we need to try to make the hole smaller.  The process 
is repeated as long as we can keep the streams flowing into or towards the hole;  Repeatedly

 Edit core.shp to make it smaller (Figure 77)
 Make a new copy demn.tif (n is 2,3,...) of the original DEM
 Edit the script rmcore.py  to make it refer to demn.tif and run it
 Load demn.tif as the new DEM and run Create streams. 
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Figure 77: Core shape reduced

If the streams still flow into the hole (Figure 78) we can repeat the process.

Figure 78: Streams flowing into reduced hole
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Eventually you should be able to reach a stage where the core shape covers only a few pixels 
and the streams will stop short of it by a pixel or two.  Select Use an inlets/outlets shapefile  
and click the Draw inlets/outlets  button to place an outlet point at the end of each incoming 
stream (Figure 79) and click Create watershed.  The subbasins are created (Figure 80).

Figure 79: Final hole: outlets added
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Figure 80: Subbasins created

If you open the attribute table for the subbasins shapefile and click on the Select all button, 
the area not yellow (Figure 81) shows the area that drains into the hole but not with sufficient 
size to form a stream. This area will be excluded from the model.  If this area is within the 
lake there is no harm.  If it includes significant area outside the lake, you can try again to see 
of the hole can be reduced, or you could try reducing the stream threshold, but this will affect 
the whole watershed and may be undesirable.  As a last resort you can edit the subbasins 
shapefile after the lake has been added, to put the excluded area within a neighbouring 
subbasin.  Then you will have to run the model as an existing watershed, remembering the 
first time at least to recalculate fields, since the area of the neighbouring subbasins will be 
wrong at first.
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Figure 81: Excluded area

10.3.7 Water routing

The rules for routing water into and through lakes are as follows:
1 Remember that channels which flowed into a lake across its perimeter were split into 
inflowing channels and channels within the lake.  The outflowing channels are split similarly.
So channels that interact with the lake are either (a) inflowing but entirely outside, (b) within,
or (c)  outflowing and entirely outside. 
2 Channel basins for channels outside the lake are routed just like channel basins not in-
teracting with lakes.  The only difference is that an inflowing channel has an outlet point cre-
ated at its outlet end (on the lake boundary), the channel is routed to this point, and the point 
is routed into the lake.  The main outflowing channel has a water point created at its source.  
100% of the lake is routed into this point, which in turn is routed  to the main outflowing 
channel.  Other outflowing channels receive by default 0% of the lake outflow.
3 Channels within the lake are removed from the model, and so are not routed.
4 The channel basins for channels within the lake may be entirely within the lake, or 
may have some area outside the lake.  In the former case they are removed from the model.  
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In the latter case, the channel basin is reduced to the area outside the lake and all flows that 
would normally be routed to the basin's channel are instead routed directly into the lake.
5 In the cases where the outlet channel is taken to be within the lake, the lake's water 
point is routed directly to the subbasin outlet at the outlet end of the channel.
6 When a watershed outlet is placed initially within the lake, or at the end of a suffi-
ciently short channel for the channel to taken into the lake, the lake's water point is routed 
directly to the watershed outlet.
7 By default in QSWAT+, all channels have a point source created at their source.  If in-
puts are defined for any of these point sources, they are routed into their channel. 
  
These rules only describe the default actions of QSWAT+.  Users can freely edit the routing 
table using the SWAT+ Editor.  

10.4 Files involved

The channels shapefile created from the delineation before lakes are added is called 
DEMchannels.shp, where the DEM raster is called DEM.tif, and is found in the 
Watershed/Shapes folder.  Channel splitting creates a new channels shapefile 
DEMchannels1.shp.  The original is retained because it can be used to locate the channels 
mentioned in messages about channels with multiple crossing points with lakes.  The 
replacement channels shapefile is created by rerunning part of delineation and the LINKNO 
values of channel reaches are likely to be different.

Other files affected by adding lakes are  the subbasins file Watershed/Shapes/ 
DEMsubbasins.shp and the channel basins Watershed/Shapes/DEMwshed.shp (not normally 
loaded).  All of these have the lake areas removed.  The last also has channel basins split 
where channels were split.  The subbasins and wshed shapefiles are later the basis for the 
subs1 and lsus1/2 shapefiles respectively.
The extra outlet points at the outlets of channels flowing into lakes, and the water points at 
the lake outlets, are added to the inlets/outlets shapefile created by snapping points to streams
and channels.  They can be made visible by reopening the delineation form, clicking the 
Review snapped button, and then clicking Cancel  (to avoid trying to rerun lake processing).

10.5 Lakes in grid models

Lakes can also be added to grid models.  This is done essentially by designating  a number of 
cells in the grid as forming lakes.

To add lakes to a grid model, first delineate it as usual:  this is the same as non-grid 
delineation except you check Make grid and pick a grid size.  Then you select the Add 
Lakes tab, and click the '...' button to select and load the lakes shapefile.    As in the non-grid 
case, each lake is reduced to its perimeter, and LakeId values are added if necessary.  Then 
the grid cells which overlap with each lake are marked as forming part of the lake if the lake 
includes at least 50% of the cell.
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In grid models, there is no distinction between streams and channels - there are only 
channels.  Each channel runs from one grid cell to an adjacent one.  So after defining which 
cells form a lake, it is possible to define channels as not interacting with the lake (neither end 
is a lake cell), inflowing (the outlet end only is a lake cell), within the lake (both ends are lake
cells) or potentially outflowing (the source end is a lake cell, the outlet is not).  As in the non-
grid case, there can  be several outflowing channels.  If there are several, the main one is 
chosen as the one with the largest drainage area, the user is informed, and as in the non-grid 
case the default routing will be 100% to the main outlet, 0% to the others.

In the non-grid case, editing of the lake perimeter, typically by dragging some of the 
perimeter points, can be done easily using the shapefile editing capabilities of  QGIS.  For 
grid models it is not so easy:  the user could edit the lake shapefile before loading it, but it is 
difficult to judge which grid cells will be included or excluded in advance.  Instead a simple 
mechanism is provided to edit the lake when it has become just a set of the cells in the 
watershed grid.  There are buttons Remove lake cells and Add lake cells.  Clicking either of 
these puts QGIS in a mode where grid cells can be selected by left-clicking in them.  You can 
hold the Ctrl key to make a multiple selection - the selected cells turn yellow - and then click 
Ok to make the change or Cancel to leave the lake unchanged.  Since there may be more 
than one lake in your model, before adding cells you need to select the appropriate lake 
identifier in the Lake number box.  

Figure 82:  Initial grid lake
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Figure 82 shows the initial state of a lake in a grid model.  (Cell numbers are removed for 
lake cells, but we refer to some cells in the lake using the numbers they would have had 
before the lake was added: the numbering system should be obvious from the figure: in each 
row cells are numbered consecutively left to right.)  We can see that the lake outlet should be 
from 2792 to cell 2791 (channel widths increase with their drainage areas), but there are also 
potential outlets into 2725 and 2529.  QSWAT+ will settle on 2792 for the main outlet and 
warn about the others, and we can see that there are only a few cells involved and leave 
things as they are.  Alternatively we could take the drainage csv file generated when we 
delineate grid models, edit it, and use it in a predefined watershed project.  We could, for 
example, change the DownSubbasin  of Subbasin 2726 to 2792 instead of 2725, and change 
that of 2530 to 2595.   A third option is to decide that this north-west corner of the lake is 
inaccurate and encroaching into another  natural basin: we need to edit the lake.  We can 
remove the lake cells occupying  cells 2726, and 2530, but then we see that 2530 is now a 
potential outlet, and we see that we need to also remove 2531, 2467, 2468 and 2469.  The 
result is shown in Figure 83

Figure 83:  Grid lake after removing some cells

In the non-grid case channels were split at the lake boundary.  We cannot split the grid 
channels, because they always run cell to cell, but we still place outlet points on inflowing 
channels and a water point on the main outflowing channel.  For inflowing channels the point
is placed at the channel outlet (so apparently inside the lake) and the routing is channel to 
point to lake.  For the outflowing  channel the point is placed at the source end of the channel 
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(again apparently inside the lake) and the flow is lake to point to channel.

10.6 Lakes in predefined watersheds

QSWAT+ supports the use of predefined watersheds, in which the user supplies the streams 
and channels, subbasins and channel drainage areas as shapefiles, and no watershed 
delineation is done.  Generally this is to avoid the delineation process changing the stream 
lines or the basin boundaries.

The principal that outputs from delineation can be used as inputs for predefined models is 
maintained: delineated models include all the necessary fields described below.

10.6.1 Predefined grid models

With predefined grid models adding lakes is very simple, and the process is the same as in the
delineated case.  The user supplies the grid and the drainage pattern, and adds the lake 
shapefile.  The lakes are converted into collections of grid cells by intersecting the lake with 
the grids, and the inflowing and outflowing channels identified.  As in the delineated case, the
lakes can be edited by adding or removing cells.

10.6.2 Predefined non-grid models

Adding lakes to predefined non-grid models is much more complicated.  As we described 
earlier, we need to split channels that cross a lake boundary into a channel outside the lake 
and a channel inside it.  The splitting is straightforward, but we also need to divide the region 
draining into the original channel into two regions, and this can only be done by delineation 
techniques.  This contradicts the idea of a predefined watershed avoiding the use of 
delineation.  So instead it is necessary for the user to provide a channel network that has 
already been split, and a corresponding watershed shapefile that defines the region draining to
each channel.  The following changes are necessary to the requirements on the input 
shapefiles for predefined non-grid models:

10.6.2.1 Lakes shapefile

This is required, with one shape for each lake.  There must be a LakeId  field in the attributes,
with each lake having a unique strictly positive LakeId value.  The shapefile is in fact only 
used to calculate the area and centroid of each lake, so it is not required, for example, to 
reduce the shapes to outer perimeters only.  The area and centroid values are always 
calculated from the geometry of each lake, regardless of any other fields which might define 
them.  The lakes shapefile should also have a RES field indicating with a value 1 if the lake is
a reservoir 2 if it is a pond, 3 if it is a wetland, or 4 if it is a playa.  If there is no such field 
reservoir is assumed.

10.6.2.2 Channels shapefile
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The channels shapefile requires four extra fields: LakeIn, LakeOut, LakeWithin, LakeMain.   
Values in these fields may be NULL (empty) or 0 (zero), indicating the channel has no 
interaction with any lake, or a value found in the LakeId field of the lakes shapefile, 
indicating that the channel flows into the lake, or flows out of it, or is within it.  Channels 
marked as flowing into a lake are regarded as having their outflow point on the lake 
boundary.  Channels marked as flowing out of a lake are regarded as having their source on 
the lake boundary.   The LakeMain field is used to give the LakeId for which the channel is 
the main outlet:  it is only  read when LakeOut has a positive value, and must have the same 
value.
The channels flowing into lakes may have DSNODEID values, but these are ignored.  The 
reason is that the requirements above are met by channels1 files created during delineation, 
and these have DSNODEID values which correspond to points added to the snapped 
inlets/outlets file.  But this file is not commonly accessed by users, and in any case predefined
watersheds typically do not need or use inlets/outlets files.  So such values are ignored.  
Outlet points are created for the inflowing channels, as in the delineated case, but this is done 
internally and no inlets/outlets file is created.  These points will of course be defined in the 
gis_points table and referenced in the gis_routing table of the project database.

10.6.2.3 Subbasins shapefile

This is assumed to correspond to the subbasins with the lake shapes removed, so that in 
particular the total watershed area will be the sum of the subbasin shape areas plus the lake 
areas.

10.6.2.4 Watershed shapefile

This defines the area draining into each channel.  As with the subbasins shapefile it is 
assumed to correspond to the drainage areas for each channel with the lake shapes removed.
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11 Parameter settings

A range of parameter settings is possible using the parameters form (Figure 84) that is opened
by clicking the QSWAT+ parameters button on the main form (Figure 2).
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Figure 84: QSWAT+ parameter form

11.1 SWATPlus directory

This directory holds a number of directories needed for QSWAT+ and SWAT+:

 Databases contains template project and reference sqlite databases, plus soil and 
weather generator databases (if installed)

 Documents contains documents like this one

 ExampleDatasets currently contains just the Robit example used in this manual.

 TauDEM539Bin contains TauDEM executables used for watershed delineation.  This 
directory is not necessary on Winows if QSWAT is also installed, since QSWAT has 
its own set of the same executables

 Tools currently contains SWATGraph, a stand-alone version of the QSWAT+ feature 
for plotting SWAT+ outputs stored in csv files.  In Windows, SWATGraph is not 
necessary if QSWAT is installed.  In Windows the Tools folder also contains 
ConvertFromArc, a tool to convert ArcSWAT projects to QSWAT+.

 SWATPlusEditor contains the SWAT+ editor and the SWAT+ executables.

The SWATPlus directory defaults to C:/SWAT/SWATPlus in Windows, to 
~/.local/share/SWATPlus or /usr/local/SWATPlus in Linux, and to ~/SWATplus or 
/Users/Shared/SWATPlus in MacOS.    It is possible to install elsewhere and then use this 
form to tell QSWAT+ the location.

Setting this parameter sets the value for all QSWAT+ projects.
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11.2 MPI bin directory

See  Appendix IV:  Installing and Using MPI.  MPI  is a tool for reducing the processing 
times with large DEMs.
Setting this parameter sets the value for all QSWAT+ projects.  The remaining parameters 
described in this section are project-specific.

11.3 Channel widths and depths

QSWAT+ uses standard formulae for estimating the widths and depths of  channels:

width=WM∗DAWE

depth=DM∗DADE

where DA is the area draining into the channel in square km, WM is the channel width 
multiplier, DM the channel depth multiplier, WE the channel width exponent, and DE the 
channel depth exponent.  The default values used for these four parameters are shown in
Figure 84.  The defaults are intended to provide typically appropriate values, but may not 
give good estimates in your area.  Changing these values and clicking Save will cause the 
values to be saved and used for calculating channel widths and depths, and also saved in the 
project file for use in the future.  Restarting the project will then place the new values in the 
parameters form if it is opened again.

The widths and depths so calculated are stored in the project database tables gis_channels and
gis_lsus.  In gis_channels they are the values called wid2 and dep2, the main channel width 
and depth, and the area used is the total area draining into the channel.  In gis_lsus they are 
the values called wid1 and dep1, the subsidiary channel width and depth, and the area used is 
the area of the channel's LSU.

If either or both of the tables gis_channels and gis_lsus exist when Save is pressed the tables 
are updated.  It is therefore possible to complete delineation or HRU creation and then update
these tables, without having to rerun delineation or HRU creation. 

The values in the database table gis_channels are also stored in the attributes of a shapefile 
rivs1.shp, which can be found in the Watershed/Shapes directory.  This is updated as the 
database table is updated.  Similarly, lsus2.shp in the same directory has the values from 
gis_lsus in its attributes, and is updated with the table.  .  (The use of the number 1 or 2 in 
these shapefile names reflects their formation.  Number 1 is created from reading files for 
subbasins, landuse, soil, etc., and a new version with number 2 is added for lsus since channel
merging changes the shapes, which show the areas draining into channels.)

11.4 Slope and length multipliers

Mean slopes and channel lengths are calculated as part of delineation.  DEMs are obviously 
only small samples of the actual terrain elevations, and so these values may poorly estimated.
They can be changed individually in the relevant project database tables, but it may also be 
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useful to correct a persistent bias by multiplying the estimated figures by a constant.  There is
a range of multipliers that can be adjusted from their default values of 1.0:

 Reach slopes multiplies slo2 values in gis_channels, the mean slope of the channel, 
which is the difference in elevation between the ends of the channel divided by its 
length.

 Tributary slopes multiplies csl  values in gis_lsus.  This is calculated as the longest 
flow path in the LSU divided by the drop along this flow path.

 Mean slopes multiplies the slo1 values in gis_subbasins, and the slope values in 
gis_lsus, and gis_hrus.  In each case the slope is a mean of the slope values recorded 
for every DEM pixel in the subbasin, LSU or HRU respectively.  The sll (slope 
length) values in gis_subbasins are also adjusted, since they are calculated from the 
subbasin's mean slope.

 Main channel length multiplies len2, the channel length (and also divides slo2) in 
gis_channels.

 Tributary channel length multiplies len1, the longest flow path (and also divides csl) 
in gis_lsus.

As with the width and depth parameters described above in section 11.3, when these values 
are changed and Save is clicked, if the relevant tables already exist they are immediately 
updated.

Also, again as mentioned in section 11.3, rivs1.shp in Watershed/Shapes contains values from
gis_channels, and  lsus2.shp values from gis_lsus and are updated together with the tables.  
subs1.shp has a similar relation to the table gis_subbasins.

11.5 Font point size

This enables users to select a larger or smaller font size for QSWAT+.  It only takes effect if 
Save is clicked and QGIS (and QSWAT+) restarted.  An attempt is made to immediately show
the effect in the Font point size label, but this is not always accurate.  The result is dependent 
on the font sizes available.

11.6 Stream burn-in depth

This is the depth in metres by which elevations are decreased along the path of the streams to 
be burned in.  Changing this parameter and clicking Save only has effect the next time the 
delineation step is done (with the burn-in option selected).

11.7 Upslope HRU drain %

When a floodplain is included in calculating LSUs and HRUs, HRUs in upslope LSUs have 
their outflowing water routed by default 90% to the channel (or reservoir or pond if the 
channel forms one) and 10% to the floodplain LSU.  The figure of 90 is changed by this 
parameter, provided it is an integer in the range 0..100 inclusive, and internally the figure of 
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10 changed so their sum is 100.  This affects the relevant entries in the gis_routing table.  The
table is adjusted immediately if it exists when Save is clicked.

12 Exporting SQLite database tables

Clicking the Export Table button on the main form (Figure 2) opens the Export SQLite 
table to csv form (Figure 85).  You can use this form to create a csv (comma separated value)
file from any SQLite database table.  Then, perhaps after editing, you can import the form 
into its original table or to another database (which will need to have the table data structure 
already defined).  This is mainly intended to support the import of csv files into QSWAT+ 
projects.  QSWAT+ supports the import of csv files for landuse lookup tables, soil lookup 
tables, usersoil tables, plant tables and urban landuse tables: see section 6.2.1.  .

Figure 85: Export SQLite table to csv form

To export a table, first use the Select database pull-down menu, which offers the Project 
database,  Project's reference database, and Other SQLite database as options.  The first two 
refer of course to the current project, and the third allows the user to browse for any SQLite 
database.  The second pull-down menu will then contain all the table names from the selected
database, allowing the user to select one.  Clicking Export will then save the database table 
to a csv file, with the user selecting its name and location.  Clicking Close closes the form.

SQLite tools like SQLiteStudio also support export of tables, but this QSWAT+ feature is 
intended as a convenience for users who do not wish to spend the time to acquaint themselves
with such tools.

13 Appendix I - Adding your own data

13.1 Preparing daily climatic data for QSWAT+
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1 The user should initially prepare station information. The station information should be 
prepared for all the climatic variables for which the user has local data. The header for the
table should consist of columns ID (station ID), NAME, LAT (latitude), LONG 
(longitude) and ELEVATION. Refer to the example dataset in the folder 
Robit/ClimateRobit, e.g. pcp.txt. 

2 The actual climate data should have the same file name as the station NAME in the 
station data (e.g. station name robpcp corresponds to file robpcp.txt). The format of the 
climate data should be as follows: the first line should be the date in the format 
yyyymmdd followed by the daily climatic data values. Missing values will be replaced by
-99. The data format for the precipitation, solar radiation, wind speed and relative 
humidity is the same. Refer to the example dataset for precipitation data in the folder at 
Robit/ClimateRobit, robpcp.txt. The only exception is for maximum temperature and 
minimum temperature, in which case the maximum temperature and minimum 
temperature are separated by a comma. Refer to the example dataset for temperature 
dataset, Robit/ClimateRobit/robtmp.txt. 

3 The actual climatic data should be saved in the same folder as the station files.

4 The units for precipitation, temperature, solar radiation, wind speed and relative humidity 
should be mm, degree centigrade, MJ/m², m/s, and decimal fraction, respectively. 

5 For each subbasin, SWAT+ uses observed climatic data from the closest station. If there is
no observed station climatic data, SWAT+ will use simulated data using the weather 
generator. The algorithm used by SWAT+ is as follows: for example, suppose there are 
weather stations with identifiers A, B and C, and tables Apcp, Bpcp, Atmp, Btmp, and 
Cslr.  Then the result will be:
 For precipitation: subbasins will use measured data from Apcp or Bpcp, according to 

whether station A or B is closer.

 For temperature: subbasins will use measured data from Atmp or Btmp, according to 
whether station A or B is closer.

 For solar radiation: all subbasins will use measured data from Cslr.

 For relative humidity: all subbasins will use simulated data.

 For wind speed: all subbasins will use simulated data.

This makes it easy for users to vary climate data if they wish, and to combine measured data 
from a number of sources. It is even possible to combine simulated and measured data for 
different subbasins: in the example above, for example, if all the values in Apcp are -99 
(missing data), while Bpcp is measured data, then subbasins nearer to station A will use 
simulated precipitation data and those nearer to B will use measured data.

13.2 Preparing landuse and soil  tables
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For each landuse or soil map the user can prepare a lookup table like Robit_landuses or 
Robit_soils and put it into the project database Demo1.sqlite in the Demo1  folder 
(QSWATPlus_Projects/Robit/Demo1). The project database is created by copying 
QSWATPlusProj2018.sqlite when New Project in the main QSWAT+ form is clicked. 

Standard landuse and soil tables, namely global_landuses and global_soils are already 
included in the project database.  These are for use with the global landuse and soil maps 
available from the SWAT website on its data page https://swat.tamu.edu/data.  If you use 
these maps then you can use these lookup tables, and the existing tables global_usersoil, 
plant, and urban in the project database are appropriate. The global maps are in latlong 
projection and will need clipping and reprojecting to your project's projection as described for
global DEMs in Appendix II.

In the case of a landuse map, the lookup table should have the string landuse in its name. 
Then it will be offered as an option for a landuse table. It must have the same structure as the 
table global_landuses in QSWATPlusProj2018.sqlite. So it must contain at least the columns 
LANDUSE_ID (type INTEGER) and SWAT_CODE (type TEXT). The LANDUSE_ID 
corresponds to the values in the landuse grid. It is possible that more than one of the 
LANDUSE_IDs maps to the same SWAT_CODE, where your data makes more distinctions 
than are supported by SWAT+. The SWAT_CODE strings are mostly 4 letters long, but can 
be up to 16 characters, and all the ones used in your map must be found in the table plant or 
the table urban, or in your own replacements for either or both of these in the project 
database.  Searching for these codes is independent of case, so that for example RICE in your 
lookup table will match rice in the plant table.

In the case of a soil map, the lookup table should have the string soil (but not usersoil) in its 
name. Then it will be offered as an option for a soil table. You should copy the structure of 
the table global_soils in QSWATPlusProj2018.sqlite. So it must contain at least the columns 
SOIL_ID (type INTEGER) and SNAM (type TEXT). The SOIL_ID corresponds to the 
values in the soil grid. All the SNAM strings you use must be as follows:

 found as SNAM values in the table global_usersoil found in the SWAT+ project 
database, or the table you have chosen to use instead, or

 found as name values in the first usersoil table if you have used the two table option: 
see below, or

 if you are using STATSGO, one of the following four options: 
1 muid  values such as AL001
2 muid+seqn values such as AL001+1
3 muid+name values such as AL001+DICKSON
4 s5id  values such as TN0042
The lookup table must use one of these options consistently.  Lookup is in the statsgo 
table in swatplus_soils.sqlite.  Where lookup target matches more than one row in the 
statsgo table the first (as ordered by increasing id values) is taken.  So the four 
examples above would all give the first row (id 1) in the table
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Unless your project is in the USA and you are using SSURGO or STATSGO soil data, you 
will need a usersoil table to define your soil properties.  QSWAT+ uses a structure which 
divides soil properties into two tables: a usersoil table giving properties for the whole soil, 
such as its hydrographic group and texture, and a usersoil_layer table giving properties for 
each layer.  But QSWAT+ also accepts the old SWAT usersoil structure in which these are 
combined.  You can use tables already provided in the project database, like global_usersoil, 
or you can create and select your own table.  The table name should include the string 
usersoil, and if  there is a separate layer table its name should be the first table name extended
with _layer.  The structure of the two tables is illustrated by the csv files in the Robit dataset 
Robit_usersoil_main.csv and Robit_usersoil_main_layer.csv.

An alternative to preparing these tables in the project database is to use .csv (comma 
separated value) files as described in section 6.2.  Note that the .csv file Robit_usersoil.csv 
used the single usersoil structure. If you choose Use csv in the usersoil menu, you can select 
Robit_usersoil_main.csv as the usersoil table, and you will then be prompted for the second 
layers .csv file, and tables Robit_usersoil_main and Robit_usersoil_main_layer will be 
created in the project database.

14 Appendix II – preparing global DEM data for QSWAT+

14.1 Introduction

You may have your own digital elevation map (DEM) for your watershed, but if you don't 
this section explains how to obtain and prepare DEM data obtainable free from the web. The 
techniques for clipping and reprojecting DEMs may also be useful for DEMs from other 
sources.
There are also notes about masking DEMs and about dealing with large DEMs in the final 
two sub-sections (7.7) that should be of general interest.

14.2 Obtaining SRTM DEM data

SRTM (Shuttle Radar Topography Mission) is a good source of DEM data for almost 
anywhere in the world. It is available at 90 metre and, since the end of 2014, 30 metre 
resolutions.

The first thing to do is to make a note of the extent of the watershed you want to model: the 
maximum and minimum latitudes and longitudes. Decimal longitudes that are west of the 
Greenwich meridian should be expressed as negative numbers: if you have a longitude above 
180°, subtract 360. Decimal degrees, rather than degrees, minutes and seconds, will be 
required for clipping later, so convert yours if necessary (just divide the minutes by 60 and 
round to 1 decimal place) and make a note of them.

Choose or create a folder for the maps to be stored. We will refer to this as the map folder.

114



14.2.1 90m data
You might like to use the less detailed 90m data if your watershed is large or if you are new 
to QSWAT+. Go to http://srtm.csi.cgiar.org/, and select the SRTM Data Search and Download
menu item. Then select GeoTiff as the file format. You can now select tiles by selecting 
Multiple Selection and clicking on them, or by selecting Input Coordinates and entering the 
extent. Then click Begin Search and on the next page select the Data Download (FTP) or 
(HTTP) for each of your tiles. You will not need the mask. Each tile comes in a zipped 
archive file containing a text file with information about SRTM (including citation data) and 
a .tif file, plus .hdr and .tfw files.  Unzip each archive and put the files in the map folder.

14.2.2 30m data
Go to http://earthexplorer.usgs.gov/ and register if it is your first visit, or log on. You won't be
able to download anything until you are logged on.

Under Coordinates, select Decimal and click Add Coordinate. Enter, the latitude and 
longitude of one of the 4 corners of the extent.  Add the other 3 corners similarly. Then above 
Enter Search Criteria select the second tab, Data Sets.

Find Digital Elevation, click on the plus sign to expand and find SRTM. Expand that and 
check SRTM 1 Arc-Second Global. Then go straight to the fourth tab, Results.

After a few seconds you should see the tiles you need listed. For each one. Click on 
Download options (the 5th symbol) and then click Download beside GeoTIFF. Save the file, 
close the Download Options form, and repeat for each of your tiles. Note that the save form 
says the file is a zipped archive, but its extension is .tif and it is not zipped.  Move the .tif 
files to the map folder.

14.3 Clipping the grids

Start QGIS and load the first grid (using Layer → Layer → Add Raster Layer, or the 
corresponding button on the left of the QGIS window). Select Raster → Extraction → Clip 
Raster by Extent  to bring up the clip form (Figure 86). Set the Input layer to the grid you just
loaded, set the Clipped (extent) by browsing to where you want to store the result, and use 
something like <grid_name>_clip_ll.tif as the file name. It is a good idea when manipulating 
grids to set the nodata value, so include in the nodata box -32768 for 90m data and -32767 for
30m data8.  You can find the appropriate value by right clicking on the entry in the Layers 
panel, selecting Properties, and selecting the Transparency  section (or look under Bands in 
the Information section.)

You also need to enter the extent you used to download the grids. It is a good idea to widen 
these somewhat, say by 0.2 of a degree, to make sure there are no problems.  Make a note of 
the values you use as you may need them again. Check Open output file after running 

8 The value should not matter, as long as it is less than any occurring in the actual data, but if it is different 
from the existing no data value it can cause problems with the existing value being accepted as an actual data
value.
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algorithm and click Run. Right click on the original, unclipped grid in the Layers panel, 
select Remove Layer and confirm. You will be left with the clipped portion. Load each of the 
other grids, and clip in the same way. 

Figure 86: Clip form

14.4 Merging the grids

You should have all the clipped grids loaded. Use Raster → Miscellaneous → Merge to open 
the Merge form (Figure 87). Select all the layers you want to merge.  Ignore the two check 
boxes.  Check the type of one of the clip files by right clicking on its legend entry, selecting 
Properties -> Information: the type is the Data type, probably Int16, and select the Output 
data type accordingly.  For Merged, browse to the map folder and choose a suitable name, 
perhaps ending in dem_ll to remind you what it is Check Open output file after running 
algorithm and click Run.
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Check your merged DEM is OK by removing the visibility of the other layers. 

Figure 87: Merge form

14.5 Reprojecting the grid

Our final task is to reproject the merged grid into an “equal area” projection, i.e. one in which
each grid cell has the same area.  The current lat-long projection is not appropriate because at 
different latitudes the same amounts of longitude will represent different distances. Universal 
Transverse Mercator (UTM) is a good general choice for the new projection. It is available 
almost everywhere, and while not exactly an equal area projection is sufficiently close for 
most SWAT modelling. We need a suitable UTM zone. We can find the zone from a map like 
http://www.dmap.co.uk/utmworld.htm, or use the formula (x + 180)/6 rounded up to the next 
integer, for a reasonably central longitude x in our area.  So, for example, if x is -100 the 
UTM zone will be 80/6, or 13.3, rounded up, to give 14. Then we note whether we are in the 
northern or southern hemisphere.

Use Raster → Projections → Warp (Reproject) to open the Warp (Reproject) form (Figure 
90).  Select the merged grid as the Input layer from the pull-down menu.  You can leave the 
Source CRS unselected as it will default to the lat-long projection of the merged raster.  The 
Target CRS will need to be set to our chosen UTM projection.  This is unlikely to be in the 
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pull-down menu unless you have used it recently, so click the Select CRS button to the right 
to bring up the Coordinate Reference System Selector (Figure 88).

Figure 88: Coordinate Reference System Selector

For zone 14 in the northern hemisphere we need to find WGS84 / UTM zone 14N. If we have
used it recently it will appear  in the upper Recently used box. Otherwise we have to find it in 
the lower box. It will appear under Projected Coordinate Systems rather than Geographic 
and can be found much closer to the bottom than the top.  However, there are a lot of 
projections and it can be tedious to find.  Instead we use the fact that a WGS84 / UTM zone 
nn in the northern hemisphere has an EPSG number 326nn, while the corresponding zone in 
the southern hemisphere has an EPSG number of 327nn. So if you know the zone and the 
north or south hemisphere you can calculate the EPSG number. Type 32614 in the Filter box 
and the one we want will immediately appear in the middle panel.  Select it there, and it will 
appear as the Selected CRS  at the bottom, along with its extent and its location shown on the
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world map (Figure 89).  Click OK.

Figure 89: Coordinate Reference System selected

Leave the Resampling method as Nearest neighbour.  Since we are keeping the original 
resolution there will be little resampling, if any.  Set the nodata value: -32768 for 90m, or -
32767 for 30m.  Set the Output file resolution to 90 for 90m SRTM, 30 for 30m.  This will 
ensure that the output has square pixels of the appropriate size.

For Reprojected, browse to the map folder and type in a suitable name, perhaps ending in 
dem_utm to remind you what it is

Uncheck Open output file after running algorithm: the projection is different from the current
lat-long projection and should be viewed in a new QGIS window.  Click Run.
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Figure 90: Reprojection form

Start a new QGIS instance (leaving the old one in case you find you made an error and need 
to redo something).  Load the dem_utm file and check it looks OK.  Note that coordinates in 
the box at the bottom are now shown as metres instead of degrees (you won't recognise the 
numbers but you will see the difference from the previous instance of QGIS).  If all looks 
well close the previous instance of QGIS.  Choose Discard when asked if you want to save 
the project.

120



14.6 Masking a DEM

QSWAT+ does not itself provide a facility for masking a DEM, because the capability is 
already in QGIS. Before showing how to mask, a note about when to do it. Masking, or 
reducing the area of the DEM to be delineated, is done for two reasons:

 To reduce the amount of time that delineation takes.

 To improve the accuracy of delineation.
The first reason is much less true now than it was some years ago because of the improved 
speed of computers. Unless your DEM is very large and detailed it will typically take a few 
minutes at most to delineate, and as you don't often repeat the process (and QSWAT+ tries to 
reduce the amount of recalculation when it is repeated, as well as supporting multi-core 
processing) reducing the area more than the rough clipping described in this document is not 
likely to be worth doing. See section Error: Reference source not found for more information 
about large DEMs.

Masking is also dangerous. If after delineation you find that part of your watershed boundary 
is on the edge of your DEM then it is quite possible that you have excluded some of the 
watershed, and it will be a good idea to reclip the DEM more generously and run again. So 
the general advice on masking your DEM is don't do it!

The second reason is much more compelling. DEMs are far from perfect representations of 
the real terrain, and delineation can easily include in the watershed areas which are known to 
be outside it. In this case, if you have a reliable map of the actual watershed boundary, you 
can use it to clip the DEM precisely.

So we assume you have a good map of the watershed boundary, which we assume is a 
shapefile with a single shape in it. We further assume it is in the projection of your final 
DEM: if it is in some other projection you can use Vector -> Data Management Tools -> 
Reproject Layer to create a new shapefile with the right projection. 

We can now use this boundary shapefile to clip our DEM.  Start QGIS, load the projected 
DEM, and then load the projected watershed shapefile (Figure 91)  Check the shape lies 
within the DEM, or we made a mistake somewhere!
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Figure 91: DEM and mask shape loaded

Then use Raster → Extraction → Clip Raster by Mask Layer to open the clip form (Error: 
Reference source not found).  Select the dem_utm from the pull-down menu as the Input 
layer, and the shapefile layer as the Mask layer  Choose the appropriate nodata value for the 
raster you are clipping, such as -32768 for a 90m SRTM.  You don't need an alpha band, you 
should match the extent of the clipped raster to the mask (or you will just create a DEM of 
the same size but with a lot of nodata) and you should keep the resolution: these will 
probably all be the defaults.  For Clipped (mask) browse to the map folder and provide a 
name like dem_clip_utm. Check Open output file after running algorithm.  Click Run. 
Remove the dem_utm to check that we have a DEM clipped to the shape.
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Figure 92: Clipping the DEM by mask

14.7 Large DEMs

Some processing times for large DEMs are shown in Table 1. These are not intended to be 
anything more than indicative: while the number of cells in a DEM is probably the main 
factor influencing processing time, it is not the only one. DEM sizes are in millions of cells: 
for example the 100 million DEM has 10000 rows and 10000 columns. You can see the size 
of your DEM by loading it in QGIS, right clicking the entry in the Layers panel and selecting 
Properties.  The Layer info section under the General tab shows the number of columns and 
rows.

The times in Table 1 are for running from after loading the DEM to the end of stream 
delineation: this includes the two most long-running TauDEM functions (D8FlowDir and 
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DinfFlowDir). Note that these two functions only need to be rerun if the DEM changes. If 
you want to change the delineation threshold, or the inlets/outlets, the rerun will be much 
faster than these times. Where there is a second time in brackets, this is for running without 
using the Message Passing Interface (MPI), i.e. with a single process. The machines used to 
obtain these figures are:

A A 32-bit laptop with an Intel T9400 2.53GHz processor with 2 cores and 2 GB of 
memory. MPI was used with 4 processes.

B A 64-bit PC with an Intel i3 3.3GHz processor with 2 cores, 4 logical processors and 
6GB of memory. MPI was used with 8 processes.

C A 64-bit PC with an Intel i7 3.4GHz processor with 4 cores, 8 logical processors and 
8GB of memory. MPI was used with 16 processes.

See Appendix IV:  Installing and Using MPI..

Machine/
DEM size

A B C

100 2100(*) 255(560) 104(450)

25 *(480) 64(140) 28(111)

12 159(205) 28(61) 12(48)

6 42(57) 8 (16) 4 (13)

4 13(22) 3(5) 1(3)

2 7(9) 1(2) 1(2)

1 3(4) 1(1) 1(1)

Table 1: Times in minutes for processing large DEMs (sizes in millions of cells)

* - run failed

There are two conclusions to be drawn from these figures:

 In this range of DEM sizes the times increase initially linearly with the size of the 
DEM, but later much more sharply. A DEM of 369 million cells processed on 
machine C took over 15 hours, much worse than the rough '1 minute per million cells' 
that you would expect for this machine from the table. Typically 'Not Responding' 
will appear at the top of the main QGIS window and/or the delineation form. This is a 
result of the TauDEM processes running in the background but using almost all the 
CPU resources. Ignore the lack of responsiveness and be patient!

 MPI only makes a substantial difference when the DEMs are above a few million 
cells.

15 Appendix III: Using a Predefined Watershed and Channel Network

The delineation form allows you to opt for a predefined watershed and channel network by 
selecting the Use existing watershed tab.
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We deal first with non-grid models in section 15.1.   Existing grid models were discussed 
earlier in section 9.2; we present precise requirements for them in section 15.2.

15.1 Non-grid models

On this tab, with Use grid model not checked,  you can select the shapefiles containing the 
watershed and its subbasins (the Subbasins shapefile), the regions draining into channels (the 
Watershed shapefile)  and the channel network (the Channels shapefile). Remember that 
channels include the streams that define the subbasins, so that the watershed shapefile is a 
finer partitioning of the whole watershed than the subbasins shapefile. These files need to 
have the same projection as the DEM. If you want to use files generated by TauDEM in a 
previous project, then such files can be found in the Watershed/Shapes subfolder of that 
project, with names ending subbasins.shp, wshed.shp and channel.shp respectively.

It is also possible, but not necessary, to specify an Outlets/Inlets shapefile, and again a file 
from the previous project may be used. If such a file is not specified, only main outlet(s) from
the watershed will be used as main outlets in the new project. You will not be able to mark 
inlets, reservoirs or ponds, but you will later be able to add automatic reservoirs by setting an 
appropriate threshold for WATR areas.

The subbasins shapefile must be a polygon shapefile (each polygon representing a subbasin) 
with the following fields:

Necessary/Optional Name Type

Necessary PolygonId Integer

Optional Subbasin Integer

The watershed shapefile must be a polygon shapefile (each polygon representing the region 
draining into a channel reach) with the following field:

Necessary/Optional Name Type

Necessary PolygonId Integer

The channels shapefile must be a line shapefile (each line representing a channel reach) with 
the following fields:

Necessary/Optional Name Type

Necessary WSNO Integer

Necessary LINKNO Integer
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Necessary DSLINKNO Integer

Optional DSNODEID Integer

Optional Length Double

Optional Drop Double

Necessary BasinNo Integer

Necessary for lakes LakeIn Integer or NULL

Necessary for lakes LakeOut Integer or NULL

Necessary for lakes LakeWithin Integer or NULL

Necessary for lakes LakeMain Integer or NULL

An outlets/inlets shapefile must be a point shapefile with the following fields:

Necessary/Optional Name Type

Necessary ID Integer

Necessary RES Integer

Necessary INLET Integer

Necessary PTSOURCE Integer

Note that the RES field has changed from QSWAT, where it had the value 1 to indicate a 
reservoir point, else 0.  Now it can also take the value 2, to indicate a pond.

A lakes shapefile must be a polygon shapefile with the following fields.

Necessary/Optional Name Type

Necessary ID Integer

Necessary RES Integer

The RES field may be 1 (for a reservoir) or 2 (for a pond).

Necessary fields must be defined in the original files. Optional fields may or may not be 
defined originally. With two exceptions defined below, if optional fields are defined, and if 
the Reuse button is checked then their values will be assumed to be correct and reused. If 
optional fields are not defined originally, or if the Recalculate button is checked, then they 
will be defined if necessary, calculated, and the calculated values inserted9. Any file may have
other fields defined: these will be ignored. The fields may be in any order.

The first exception is the DSNODEID field. This is necessary if an outlets/inlets shapefile is 

9 Changes to these files are only made to the copies of the originals in the Source folder of the project.
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specified, in which case it is assumed to be correct and its non-negative values must refer to 
ID values in that file. DSNODEID values are never recalculated.

The second exception is the Subbasin field in the subbasins shapefile. Even if present and 
Reuse is selected it is checked to have suitable values for the SWAT+ basin numbers. These 
must be strictly positive and unique, except for basins which are empty, when the Subbasin 
values must be zero. If the Subbasin values do not meet these requirements they are 
recalculated.

There are some conditions imposed on the fields. The PolygonId values in the watershed 
shapefile must be unique, non-negative, and must equal the corresponding WSNO values in 
the channels shapefile: each polygon must have exactly one channel reach, and each channel 
reach must have exactly one polygon. These two fields provide the connection between the 
watershed polygons and the channel reaches. The LINKNO values must also be unique and 
non-negative (and will typically but not necessarily be the same as the WSNO numbers.). The
DSLINKNO (downstream link) values must each be another LINKNO value or -1, where -1 
indicates a watershed outlet. 

The BasinNo field in the channels shapefile provides the link between the channels and the 
subbasins: each BasinNo value must be a PolygonId in the subbasins shapefile, defining the 
subbasin within which the channel is located.

Files previously generated by TauDEM will meet all these conditions, and their values may 
be safely reused.

There is also an assumption made about the  channels shapefile. Each channel reach is either 
a single line, represented as a sequence of points, or a collection of such lines. The first point 
in each line may represent the upstream (source) end and the last represent the downstream 
(outlet) end, or vice versa. TauDEM creates stream reaches with the first point at the outlet 
end, but either orientation is accepted by QSWAT+. The assumption is that the orientation is 
the same for all the reaches. The orientation is checked by finding a reach with an upstream 
or downstream reach where the ends of the reaches are within one dem cell of each other: 
normally such ends will exactly coincide.  When a reach is a collection of lines, these must 
link together.

The last four entries for the channels shapefile are only necessary if one or more lakes are 
included.  The values may be positive integers, in which case they must be lake identifiers in 
the lake shapefile (which needs a field LakeId defining the lake identifier), or 0, NULL or 
empty, indicating no interaction with a lake.  At most one of the three fields LakeIn, LakeOut 
and LakeWithin may have a positive value, indicating that the channel flows into, out from, 
or entirely within the identified lake respectively.  One of the LakeOut channels for each lake 
should have the same lake identifier in its LakeMain field, indicating that it is the main outlet 
for the lake.  Subbasin and watershed shapefiles need no additional fields for lakes, but must 
cover only the region outside the lakes.  See section 10.6.2.
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The optional fields are (if necessary) calculated as follows:

Field Calculation

Subbasin For subbasins which are not empty and not upstream of an inlet, a unique
positive integer.  These will be the subbasin numbers for use by SWAT+. 
For subbasins which are empty or upstream of an inlet, 0.

Length The total length in metres of the straight line segments forming the reach.

Drop The absolute difference in metres between the elevations of the end 
points of the reach.

Note that if a predefined watershed is chosen then the length of the longest flow path along 
channels in the subbasin is used for the maximum flow length in that subbasin.

15.2 Grid models

Setting up an existing grid model was described in section 9.2.  In this section we describe 
the requirements on the existing files used.

The grid shapefile  is a polygon shapefile defining the square shapes that together define the 
watershed.  Each such polygon is treated as a subbasin, and so has a single stream reach 
associated with it.  With grid models there is no further subdivision based on channels: 
channel and stream are the same.

The grid shapefile has the following fields:

Necessary/Optional Name Type

Necessary PolygonId Integer

Optional DownId Integer

Optional Subbasin Integer

PolygonIds must be non-negative unique integers.  DownIds are optional (and ignored) if 
drainage is defined by Stream drainage or by Drainage table but otherwise must be either 
another  PolygonId value (indicating that drainage from this polygon is to the polygon with 
that PolygonId value) or -1 (indicating a watershed outlet).  The drainage pattern so described
must not be circular: following the pattern from any polygon must eventually lead to an 
outlet.  

If subbasin values are included they will be used for the SWAT+ subbasin numbers if they are
unique and positive.  Otherwise they will be recalculated.

If drainage definition is by Stream shapefile then a stream shapefile is required, with the 
following fields:

Necessary/Optional Name Type
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Necessary WSNO Integer

Necessary LINKNO Integer

Necessary DSLINKNO Integer

Optional DSNODEID Integer

Optional Length Double

Optional Drop Double

The WSNO values must be unique and each must be a PolygonId value in the grid shapefile 
(and each polygon in that file must have its id as a WSNO value in the streams shapefile).  
The LINKNO - DSLINKNO values define the drainage pattern, so the LINKNO values must 
be unique and non-negative, and the DSLINKNO values all -1 (indicating a watershed outlet)
or another LINKNO value.  Drainage must not be circular.

If DSNODEID values are included they are used as references to the inlets/outlets shapefile 
and should exist as ID values in that file.

If Length and Drop values are provided and Reuse is checked then these will be used as the 
length in metres and the drop in metres of their stream reach.  Otherwise these values will be 
calculated.

An outlets/inlets shapefile, if provided, must be a point shapefile with the following fields:

Necessary/Optional Name Type

Necessary ID Integer

Necessary RES Integer

Necessary INLET Integer

Necessary PTSOURCE Integer

If drainage definition is by Drainage table then a comma-separated value (.csv) file must be 
identified.  Its first line is assumed to be column headings and is ignored.  The following lines
must consist of pairs of integers, the first being a PolygonId value from the grid shapefile, 
and the second either another PolygonId value or -1.  All polygons in the grid shapefile must 
be represented.  The drainage file is just another way of presenting the PolygonId - DownId 
relationship that may be contained in the grid shapefile, and is provided as an alternative for 
users who wish to define a particular drainage pattern on a grid model.  A suitable initial 
drainage table is created when a grid model is created by delineation, and may be found as 
<proj>drainage.csv in the Watershed/Shapes directory, where <proj> is the project name.  

16 Appendix IV:  Installing and Using MPI 
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This section is mainly for Windows.  On Linux and Mac MPI is standard, and comes as Open
MPI.  

QSWAT+  uses TauDEM, Terrain Analysis Using Digital Elevation Maps, as the main 
component for doing watershed delineation.

The current version of TauDEM is designed for modern multicore architectures. A multicore 
CPU has more than one processor: 2, 4, even more. By using an implementation of the 
Message Passing Interface (MPI), TauDEM can take advantage of multiple cores, splitting 
tasks into several processes distributed between them, and speeding up calculations. It is also 
able (provided your machine has enough memory) to process very large DEMs: up to 4GB.

The implementation of MPI used by TauDEM on Windows is MS-MPI from Microsoft, 
which is free to download and use.  By default MS-MPI is not installed in Windows when 
you install QSWAT+: TauDEM will run without it, in "single process" mode.

You may obtain and install MS-MPI, and we give some instructions below. Then QSWAT+ 
will take advantage of it. There is no point in doing this unless you have a multicore CPU, 
and probably not much unless you have large DEMs: see Appendix II for some examples of 
processing times on large DEMs.

It is possible the first time you run one of the TauDEM executables after installing MS-MPI 
that you get a TauDEM error, and in the details you will see

Fatal protocol error: check version between Mpiexec.exe, Msmpi.dll, and Smpd.exe.

The way to fix this is to remove or make inaccessible the copy of msmpi.dll that is stored 
with the TauDEM executables in order to enable them to run without MS-MPI. Go to the 
directory SWATPlus/Taudem539Bin and rename msmpi.dll to, say, msmpidll (which is better 
than removal as you can restore it later if necessary).

16.1 Installing MS-MPI

Note that you need to be an administrator to install MS-MPI.

 Download the MS-MPI installer MSMpiSetup.exe from
http://msdn.microsoft.com/en-us/library/bb524831%28v=vs.85%29.aspx and install it.

 Restart the machine (otherwise it will not be able to find the executable 
mpiexec.exe).

 On a 32-bit machine there can be a problem installing and running MS-MPI. If 
MSMPISetup will not run you need the 2008 version: see below. If the installer 
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runs, after restarting your machine you should check all is OK by opening a 
command window and running the command mpiexec -help. If there is an error 
saying that mpiexec is not a valid 32-bit command then download and install the 
2008 version of MS-MPI from 
http://www.microsoft.com/en-gb/download/details.aspx?id=14737.

16.2 Configuring QSWAT+ to use MPI

On the QSWAT+ main screen there is a QSWAT parameters button.  Clicking this enables 
users to set the location of mpiexec.exe (by default C:/Program Files/Microsoft MPI/Bin).  
Users should also make sure Use MPI is checked: this is checked by default if the MPI Bin 
directory exists.  Then MPI will be used during watershed delineation provided the Number 
of processes spinbox in the Delineate watershed form is set to some positive number.  This 
should be left at zero if MPI is not installed.  See Appendix II for some example times for 
large DEMs on different machines with typical settings of the number of processes.

16.3 Blocking network access  

MS-MPI supports multi-process computations across several machines. So you may get a 
Windows firewall query as to whether you want to allow the MS-MPI program manager, 
smpd, access to networks. Since TauDEM only runs multiple processes inside your machine 
you may Cancel access (unless, of course, you are using MS-MPI for other purposes for 
which it needs network access).

Separate TauDEM executables (D8FlowDir, DInfFlowDir, etc) may also raise the same 
query, which is annoying - but it only happens the first time you use them!
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Figure 93: Cancelling network access for MPI

17 Appendix V: Conversion from ArcSWAT to QSWAT+

This section applies only to Windows.

17.1 Purpose

The purpose of this tool is to help users migrate from using ArcSWAT to using QSWAT+.  It 
is only concerned with reusing data developed for ArcSWAT projects.  As well as reading this
guide, users will also need to acquaint themselves with QGIS and QSWAT+ documentation. 
The essential steps in QSWAT+ are much the same as ArcSWAT.  Creating the model consists
of first delineating the watershed, then combining the delineated watershed with landuse and 
soil data, and defining HRUs.  At this point the work with GIS is complete and an editor is 
used to add weather data, edit inputs as required, and then run SWAT+.

The conversion tool has three particular purposes in mind, for which it offers Full , Existing, 
and No GIS options.

Full conversion is for users who want to rebuild their ArcSWAT project from scratch, 
and take full advantage of the new features of QSWAT+.  After conversion, they will 
be at the start of their SWAT+ project, about to do watershed delineation.  The data 
they need that could be collected from the ArcSWAT project: the maps, soil data, 
weather data, etc. will be available, and they will be able to create a model as close to 
or as different from their ArcSWAT project as they wish.

Existing conversion is an option for those who aim to keep their model as close as 
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possible to the ArcSWAT one.  An immediate problem with shifting from Arc GIS to 
QGIS is that the watershed delineation software is different, and can give different 
results.  Watershed boundaries may shift, streams may move, the numbers and 
boundaries of subbasins may change.  To avoid this, the existing option uses the 
subbasins and streams generated from Arc GIS as an existing watershed, and so 
preserves the watershed boundary, the streams and the subbasins.   No delineation is 
done in QGIS, so multiple channels within subbasins cannot be created: all HRUs will
drain into the main channel, as in ArcSWAT.  Adding landuse and soil maps is done 
within QSWAT+, as is HRU calculation, so the details of HRUs may differ from the 
ArcSWAT model.  A major advantage of the existing option (shared with the full 
option) is that since there are subbasin, stream and HRU maps inherited or created 
that are consistent with the model, they may be used for geographic visualisation of 
results.

No GIS conversion is an option for users who just want to run SWAT+ on their 
existing model without any preparation like delineation or defining HRUs.  Nothing is
done in GIS, so the subbasins , streams and HRUs are not changed.  But no 
geographic visualisation of results will be possible.  
 

The conversion tool copies much of the ArcSWAT project, and then changes the contents
of some copied files, but it does not affect any of the files in the ArcSWAT  project.  Nor 
does it rely on them afterwards: QSWAT+ always maintains the files it uses within its 
own project structure.  So your ArcSWAT project is safe, and you can change it or delete 
it later without affecting the QSWAT+ project.

17.2 Instructions

Run C:/SWAT/SWATPlus/Tools/ConvertFromArc/runConvertFromArc.bat by double-clicking 
on it or using it as a command in a command or shell window.   If you didn't use a command 
or shell window one will open, and you will see messages there as the conversion progresses.
You will be asked to locate the existing ArcSWAT project directory.  You can recognise you 
are in the right place as this directory will contain within it at least the directories called 
Watershed, Scenarios, and RasterStore.idb.  Then you are asked to identify a parent directory 
for your QSWAT+ project.  This should be an existing directory (though you can create one 
on the fly if you wish).  Note that you are not selecting the QSWAT+ project directory, since 
this is about to be created, but only where that project directory is to be placed.  Do not try to 
arrange the ArcSWAT and parent directories so that one is a descendant of the other, as this 
would cause problems (and the tool will prevent you in any case).  

Once you have selected the parent directory you will be invited to reuse the ArcSWAT project
name or create a new one.  Once the name is chosen, the tool checks to see if the QSWAT+ 
project directory exists already.  If it does, the tool checks that you wish to delete it, and does 
so if you confirm that it should.  

Deletion of an existing directory to make the QSWAT+ project directory sometimes seems to 
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fail, with a message being displayed  to say so.  Sometimes this message appears although the
deletion has in fact taken place.  If this happens you can do the following:

 Check with Windows Explorer if the directory exists and if so use Windows Explorer 
to delete it.

 If there is still a problem, check that there is nothing else (like another Windows Ex-
plorer window) accessing the directory or one below it.

 Open the Task Manager (right click in the taskbar to find it), switch to the Details tab, 
and kill any processes with Name python.exe.  Python processes seem often not to die 
when they are exited.

 If all else fails and you still cannot delete a directory, reboot the machine. 

When  the QSWAT+ project directory has been created, as a directory with the project name 
within the parent directory, the conversion tool creates all the subdirectories needed, and sets 
up a new project database, and reference database.  

Then the conversion tool opens a  form for you to make the choice between Full, Existing, or
No GIS conversion.

If you choose Full or Existing, a new project file is created (a .qgs file with the project name 
in the project directory) and the DEM, landuse and soil rasters and shapefile maps from the 
ArcSWAT project are copied in, rasters into Watershed/Rasters and shapefiles into 
Watershed/Shapes.   In this process the DEM is converted to a GeoTiff, as this is required by 
QSWAT+ delineation.

QSWAT+ normally uses two shapefiles to mark points.  The first is the inlets/outlets shapefile
and includes the main outlet(s) and any inlets that were defined in the ArcSWAT model.  Note
the Monitoring Points shapefile generated by ArcSWAT includes points at stream junctions as
well as main outlets and any extra points defined by the user.  QSWAT+ does not include in 
its inlets/outlets shapefile the points which are stream junctions: they are implicit in the 
model.  This means that if you have marked any additional points as monitoring points (and 
which have created subbasin boundaries) and are using the Full option you will need to add 
them by hand: QSWAT+ includes a facility for adding more outlets manually.

If you are using the Full option, delineation will use the inlets/outlets shapefile.  It is possible
that some points in that file will not snap to the stream network that QSWAT+ calculates.  If 
this happens, you can fix it either by editing the inlets/outlets shapefile using the shapefile 
editing capabilities of QGIS, and dragging the affected points to their streams, or it may be 
sufficient to increase the snap threshold from its default value of 300m.

If you have reservoirs or point sources they will be added to the inlets/outlets shapefile.    
QSWAT+ can also define reservoirs itself if it finds areas of water above a user-definable 
threshold percentage of a landscape unit, so you may find later that your reservoirs in the 
inlets/outlets shapefile become unnecessary.  If you choose this option in QSWAT+  and it 
creates a reservoir from one or more channels where you marked a reservoir, then it may be a 
good idea to return to delineation, remove the reservoir from the inlets/outlets file and rerun 
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delineation.  The marking of a reservoir and then choosing to create reservoirs on channels 
with a threshold amount of water in their drainage basins is a way of stopping adjacent 
channels being merged to form single reservoirs, so unless this is what you want the marked 
reservoir should be removed.   

The numbering of reservoirs and point sources is likely to be different from the ArcSWAT 
numbers.  You can check what numbers have been given to a point source or reservoir by 
selecting the item in the inlets/outlets shapefile in QGIS and using the Identify Features 
button to find the ID value.

If in ArcSWAT you marked a subbasin outlet and later added a reservoir to that subbasin, the 
reservoir is placed at the same position as the outlet.  This causes problems with QSWAT+ 
watershed delineation (when using the Full option) because it will only use one of the two 
points.  To prevent this, move such reservoirs a little upstream before running delineation.  To
do this in QGIS 3, first select the inlets/outlets shapefile in the Layers panel, uncheck the box 
in the inlets/outlets legend beside Outlet, so that outlets are not visible and you won't select 
one by accident.  Then click the yellow pencil Toggle editing button to start editing. Click the 
Vertex tool button (third right from Toggle editing).  When you then slide the mouse over a 
reservoir in the map canvas, it turns red.  Left click on it and slide the mouse a little upstream.
A small red cross slides with the mouse, showing that you have grabbed the reservoir.  Left 
click again to place the reservoir in the new location (on a channel, of course).  Finally click 
the Toggle edit button again, and confirm the changes are to be saved.  Make the outlets 
visible again so you can see they have not been moved.

If you have added point sources to all subbasins in ArcSWAT  and are using the Full option, 
you might like to remove them before doing delineation.  QSWAT+ will add point sources to 
all channels, so you are very unlikely to need the ones you added, and they will cause 
unnecessary divisions between landscape units.  To delete a point source, select the 
inlets/outlets shapefile in the Layers panel, click the yellow pencil Toggle editing button to 
start editing, hold Ctrl and click on each of the point sources in the map canvas in turn.  Each 
will turn yellow.  If you make a mistake release Ctrl and click away from any point to cancel 
the selection.  When you have selected all you want to remove, click Delete Selected (red 
dustbin), then click the Toggle edit button again, and confirm the changes are to be saved.

 If you use the Existing option the inlets/outlets shapefile is not used.  The subbasins 
shapefile from ArcSWAT is used as both the Subbasins shapefile and the Watershed shapefile,
and the stream network is used as the Channels shapefile.  QSWAT+ allows one stream but 
multiple channels within subbasins, and the Watershed shapefile defines the areas draining 
into channels.  Since ArcSWAT did not support such a feature, channels are set the same as 
streams.  Since we also use the subbasin numbering from ARCSWAT, reservoirs and point 
sources should be correctly placed: no correction as with the Full option is necessary.  The 
conversion tool adds the attributes required by QSWAT+  to the various shapefiles, so 
running the delineation form should involve no more than clicking Run and then OK.
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17.3 Landuse and soil data

For both Full and Existing options, the landuse and soil maps from ArcSWAT are copied.   
We also need the relevant lookup tables (unless the soil map is SSURGO).  Users are invited 
to choose to use their own comma separated value(CSV) file for each of landuse and soil if 
they have one (they can  supply it when they run QSWAT+).  Otherwise the following 
procedure is used to create lookup tables:

 The landuse and soil maps are read, and percentages of each value occurring in them 
are calculated.

 The percentages of the watershed for each landuse and soil are read from the Arc-
SWAT project's LanduseSoilsReport.txt

 The two lists are matched by being placed in descending order of percentage, which 
should give the relation between map value and landuse or soil name that comprises 
the lookup table.  

 If the lengths of the lists differ the percentages from the map are reported in  
landuse_map_percentages.txt or soil_map_percentages.txt which is placed in the 
QSWAT+ project directory for  manual comparison with the ArcSWAT LanduseSoils-
Report.txt, and no CSV file is generated.

 If consecutive percentages in a list differ by less than one percent, or if percentages in 
corresponding lists differ by more than one percent, the user gets a warning message.  
If there are percentages which are themselves less than one percent, the user is also 
warned.

 The CSV files are saved as landuse_lookup.csv and soil_lookup.csv in the project dir-
ectory.

 When, later, QSWAT+ is run there is an option Use csv for the landuse and soil 
lookup tables which allows these files to be read (and stored as database tables for fu-
ture runs of QSWAT+).   In the meantime users can inspect these files and correct 
them if necessary.  This will certainly be necessary if in the ArcSWAT project more 
than one map value was mapped to the same soil or landuse.

The landuse and soil maps saved in the ArcSWAT project have been clipped to the ArcSWAT 
watershed boundary.  This is convenient for creating lookup tables, since the percentages 
calculated from maps are correct for the watershed, but a disadvantage when using the Full 
option as the QSWAT+ watershed may not agree precisely with the ArcSWAT one.   
QSWAT+ will report if the percentage of the watershed covered by the landuse or soil map 
falls below 95%.  If this happens users should, if possible, replace the landuse and soil maps 
with unclipped maps.  QSWAT+ does not initially create HRUs where soil or landuse is not 
defined, but it will later enlarge all HRUs proportionately so that their total area is the same 
as the watershed. So falling below this 95% threshold may not be too much of a problem if 
the unclipped maps are not available.

17.4 Other data

For all three options (Full, Existing,  and No GIS) weather generator, observed weather, and 
some reference data is recovered from the ArcSWAT project.
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17.4.1   Weather generator data

The ArcSWAT Default/TxtInOut directory is searched for .wgn files, each of which contains 
data for a weather generator station.  Each different station has its data added to the 
weather_wgn_cli  and weather_wgn_cli_mon tables in the QSWAT+ project database.

17.4.2 Observed weather gauges

The ArcSWAT Default/TxtInOut directory is searched for pcp1.pcp, tmp1.tmp, hmd.hmd, 
slr.slr and wnd.wnd files.  If any are found, it (and for precipitation and temperature its 
successor files if any) are used to create the data for weather gauges of the appropriate 
category.  Data about the gauge is placed in weather_files and weather_sta_cli  tables in the 
QSWAT+ project database, and the observed data itself placed in appropriate files in the 
QSWAT+ project's TxtInOut directory.
The conversion tool also attempts to read the tables SubHmd, SubSlr and SubWnd tables in 
order to discover the locations of the gauge stations for relative humidity, solar radiation and 
wind speed.  If the ArcSWAT project did not have any observed data in any of these 
categories, the corresponding table will not exist, and failure to read the table is reported 
during conversion. These messages may be ignored.

17.4.3 Reference data

Data in the tables crop, fert, pest, septwq, till,  and urban tables in the ArcSWAT project's 
reference database may have been edited by the user.  To make such changes available in the 
QSWAT+ project, data from these tables is extracted and placed in tables arc_plant, 
arc_fertilizer, arc_pesticide, arc_septic, arc_tillage and arc_urban in the QSWAT+ project 
database. 

17.4.4 Inlet and point source data

In each ArcSWAT scenario's TxtInOut  directory, the fig.fig file is read to find recday, recmon,
recyear or reccnst commands.  The corresponding data files are converted into the csv format 
used by SWAT+.  Daily, monthly and yearly files are converted into files with the same name,
but with extension .csv,  placed in the corresponding SWAT+ project's scenario's TxtInOut 
directory.  Average annual data files (from reccnst commands) are amalgamated into a single 
file called rec_const.csv in the SWAT+ project's scenario's TxtInOut directory.  Each data file 
contributes one record to this file, and the name of this record (its first field) is generated as 
follows.  If the data file's name was Np.dat, where N consists of one or more digits, then the 
name is ptN.  Similarly Ni.dat gives a name inN.  Otherwise the new name is the old one 
prefixed by x, to make sure it starts with a letter.

17.4.5 Dates

Start and end dates, plus the NYSKIP value  for the simulation are read from the ArcSWAT 
project's file.cio and placed in the QSWAT+ project's time.sim and print.prt files respectively.
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18 Appendix VI: Conversion from QSWAT to QSWAT+

This section applies only to Windows.

18.1 Purpose

The purpose of this tool is to help users migrate from using QSWAT (or QSWAT3) to using 
QSWAT+.  It is only concerned with reusing data developed for QSWAT projects.  As well as 
reading this guide, users will also need to acquaint themselves with QSWAT+ documentation.

The essential steps in QSWAT+ are much the same as QSWAT.  Creating the model consists 
of first delineating the watershed, then combining the delineated watershed with landuse and 
soil data, and defining HRUs.  At this point the work with GIS is complete and an editor is 
used to add weather data, edit inputs as required, and then run SWAT+.

The conversion tool has two particular purposes in mind, for which it offers Full  and No 
GIS options.

Full conversion is for users who want to rebuild their QSWAT project from scratch, 
and take full advantage of the new features of QSWAT+.  After conversion, they will 
be at the start of their SWAT+ project, about to do watershed delineation.  The data 
they need that could be collected from the QSWAT project: the maps, settings like 
thresholds that are common to QSWAT and QSWAT+, soil data, weather data, etc. 
will be available, and they will be able to create a model as close to or as different 
from their QSWAT project as they wish.

No GIS conversion is an option for users who just want to run SWAT+ on their 
existing model without any preparation like delineation or defining HRUs.  Nothing is
done in GIS, so the subbasins, streams and HRUs are not changed.  But no geographic
visualisation of results will be possible. 
  

18.2 Instructions

18.2.1 Prerequisites

We assume you already have QSWAT or QSWAT3: the conversion tool is in fact supplied 
with QSWAT (and from now on we use QSWAT to include QSWAT3).  You will need to 
install QSWAT+, and a suitable version of QGIS, probably QGIS 3.22 as instructed in the 
QSWAT+ user manual.  You will also need to install the QSWAT+ Editor from the SWAT 
website.

18.2.2 Conversion

Run C:/SWAT/SWATEditor/runConvertToPlus.bat by double-clicking on it or using it as a 
command in a command or shell window.   If you didn't use a command or shell window one 
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will open, and you will see messages there as the conversion progresses.
You will be asked to locate the existing QSWAT project file (.qgs or .qgz).  Then you are 
asked to identify a parent directory for your QSWAT+ project.  This should be an existing 
directory (though you can create one on the fly if you wish).  Note that you are not selecting 
the QSWAT+ project directory, since this is about to be created, but only where that project 
directory is to be placed.  Do not try to arrange the QSWAT and parent directories so that one 
is a descendant of the other, as this would cause problems (and the tool will prevent you in 
any case).  

Once you have selected the parent directory you will be invited to reuse the QSWAT project 
name or create a new one.  Once the name is chosen, the tool checks to see if the QSWAT+ 
project directory exists already.  If it does, the tool checks that you wish to delete it, and does 
so if you confirm that it should. 
 
Deletion of an existing directory to make the QSWAT+ project directory sometimes seems to 
fail, with a message being displayed  to say so.  Sometimes this message appears although the
deletion has in fact taken place.  If this happens you can do the following:

 Check with Windows Explorer if the directory exists and if so use Windows Explorer 
to delete it.

 If there is still a problem, check that there is nothing else (like another Windows Ex-
plorer window) accessing the directory or one below it.

 Open the Task Manager (right click in the taskbar to find it), switch to the Details tab, 
and kill any processes with Name python.exe or python3.exe.  Python processes seem 
often not to die when they are exited.

 If all else fails and you still cannot delete a directory, reboot the machine. 

When  the QSWAT+ project directory has been created, as a directory with the project name 
within the parent directory, the conversion tool creates all the subdirectories needed, and sets 
up a new project database, and reference database. 

You may see a couple of messages “libpng warning: iCCP: known incorrect sRGB profile”.  
This warning is a known feature of QGIS and can be ignored. 

Then the conversion tool opens a form for you to make the choice between Full or No GIS 
conversion.

If you choose Full , a new project file is created (a .qgs file with the project name in the 
project directory) and the DEM, landuse and soil rasters and shapefile maps from the QSWAT
project are copied in, rasters into Watershed/Rasters and shapefiles into Watershed/Shapes.  
All scenarios are copied, as in the No GIS option: see below.

If you choose No GIS. an empty project file is created and the QSWAT+ directory structure is
created.  The DEM, landuse and soil rasters are not copied, and neither are most of the 
shapefile maps created in the QSWAT project.  But the Scenarios directory is copied in its 
entirety, which means in particular that the TablesOut directories in the default and any saved 
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scenarios are copied (and renamed Results).  The Default scenario will be overwritten when 
you run SWAT+, but any saved scenarios (plus the default one if you save a copy before 
running SWAT+) will be available for visualisation and comparison with the result of running
SWAT+.

18.3 Data

For both options (Full and No GIS) landuse, soil, weather generator, observed weather, and 
some reference data is recovered from the QSWAT project.

18.3.1 Landuse data

The data from the crop and urban tables in the QSWAT project reference database is copied 
into tables plant and úrban in the QSWAT+ project database.

18.3.2 Soil data

If the QSWAT project did not use STATSGO or SSURGO soils, the data from table usersoil 
in the QSWAT project reference database is copied into a table usersoil in the QSWAT+ 
project database.

18.3.3   Weather generator data

The QSWAT Default/TxtInOut directory is searched for .wgn files, each of which contains 
data for a weather generator station.  Each different station has its data added to the 
weather_wgn_cli  and weather_wgn_cli_mon tables in the QSWAT+ project database.

18.3.4 Observed weather gauges

The QSWAT Default/TxtInOut directory is searched for pcp1.pcp, tmp1.tmp, hmd.hmd, slr.slr 
and wnd.wnd files.  If any are found, it (and for precipitation and temperature its successor 
files if any) are used to create the data for weather gauges of the appropriate category.  Data 
about the gauge is placed in weather_files and weather_sta_cli  tables in the QSWAT+ 
project database, and the observed data itself placed in appropriate files in the QSWAT+ 
project's TxtInOut directory.

18.3.5 Reference data

Data in the tables fert, pest, septwq, and till tables in the QSWAT project's reference database 
may have been edited by the user.  To make such changes available in the QSWAT+ project, 
data from these tables is extracted and placed in tables of the same name in the QSWAT+ 
project database. 

18.3.6 Inlet and point source data

In each QSWAT scenario's TxtInOut  directory, the fig.fig file is read to find recday, recmon, 
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recyear or reccnst commands.  The corresponding data files are converted into the csv format 
used by SWAT+.  Daily, monthly and yearly files are converted into files with the same name,
but with extension .csv,  placed in the corresponding SWAT+ project's scenario's TxtInOut 
directory.  Average annual data files (from reccnst commands) are amalgamated into a single 
file called rec_const.csv in the SWAT+ project's scenario's TxtInOut directory.  Each data file 
contributes one record to this file, and the name of this record (its first field) is generated as 
follows.  If the data file's name was Np.dat, where N consists of one or more digits, then the 
name is ptN.  Similarly Ni.dat gives a name inN.  Otherwise the new name is the old one 
prefixed by x, to make sure it starts with a letter.

18.3.7 Dates

Start and end dates, plus the NYSKIP value  for the simulation are read from the QSWAT 
project's file.cio and placed in the QSWAT+ project's time.sim and print.prt files respectively.
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